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About
This Book

IN THIS CHAPTER

How Call Logging At a
Glance is Organized

Customized Call Logging
Screens

Users, Roles & Teams

Other HEAT
Documentation
Resources

We, at GoldMine Software Corporation, have a
rich heritage of commitment and service to the
Help Desk and Support Management Center

industries. Our founder, Ron Muns, is also the founder of
the Help Desk Institute. So, we like to think of ourselves as
the pioneers in Help Desk and Support Management
Center automation.

We now lead the industry with the HEAT product. HEAT is
a 100-percent customizable system for automated call
tracking, problem resolution and management, messaging,
reporting and trend tracking.

Call Logging is the heart of HEAT. It provides you with the
tools you need to log and track your calls and resolve them
quickly. To assist you in learning about Call Logging as
quickly and comfortably as possible, we have developed
the Call Logging At a Glance manual. Chapters are broken
out by function, and tasks are broken down into small,
easy-to-absorb chunks. Each task is laid out step-by-step
with a corresponding Call Logging graphic image.
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How Call Logging At a Glance is
Organized

Chapter 1

About This Book

This chapter provides an orientation to the Call Logging At a
Glance manual, as well as Call Logging terminology.

Chapter 2

Call Logging

The Call Logging chapter shows you how to launch Call
Logging, discusses each element of the Call Logging window,
and defines the terms used when logging a call.

Chapter 3

Customer Records

The Customer Records chapter discusses the different types
of Customer Records: Profile, Contacts, Configuration, and
Call History.

Chapter 4

Call Groups

The Call Groups chapter discusses both Call Groups and Hot
Lists, a specialized type of Call Group. Call Groups provide a
way of organizing and searching for Call Records.

Chapter 5

Finding Information

Finding Information shows you how to generate both simple
and complex searches.

Chapter 6

First Level Support

The First Level Support (FLS) chapter shows you how to use
the HEAT knowledge-base tool.

Chapter 7

Reports

This chapter discusses reports that you can generate through
Call Logging and Crystal Reports, as well as management
reports using the HEAT Answer Wizard.

Chapter 8

AutoTask

AutoTask explains how to automate certain tasks in HEAT.
Many of the Call Logging functions can be set up to execute
with the click of a button.

Chapter 9

Sharing Information

The Sharing Information chapter discusses how to use Alert
Monitor and SupportMail.

Chapter 10

User Preferences

The User Preferences chapter explains how you can
customize Call Logging for your workstation.

Appendices

See the appendices for a listing of Call Logging keyboard
shortcuts.
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Customized Call Logging Windows
Virtually every aspect of HEAT can be custom tailored to meet
your organization�s needs. That means the Call Logging
graphic images in the Call Logging At a Glance manual may
be a little different from yours, but the general idea is the
same.

Users, Roles, and Teams
Throughout this manual you will notice that we talk about
users, roles, and teams. Here are brief definitions:
¨ A user is a person who works in the HEAT system. The

System Administrator creates a user profile for each user
and can edit and delete users.

¨ A role is a user�s function in the HEAT system. Each user
has one and only one role. Several users can have the
same role. The role determines the user�s security rights
for each area of the HEAT system. Examples of roles
include Tracker, Manager, Screener, and Team Lead. The
system administrator can create, edit, and delete roles, and
assign a role to each user.

¨ A team is a collection of one or more users who work on a
common project, or toward a common goal. Examples of
teams include Network Support, First Shift, and
Hardware Technicians. A user may be on one or more
teams, or no team. The system administrator can create,
edit, and delete team descriptions, and assign users to
teams.

Other HEAT Documentation
Resources
¨ HEAT Admin Modules Manual
¨ HEAT Install Guide
¨ HEAT Modules Manual
¨ HEAT Managers Tools
¨ iHEAT
¨ HEAT Self Service





2

CALL LOGGING   2-1

Call
Logging

IN THIS CHAPTER

Call Logging Terms

Creating Call Records

Call Details

Assignments

Journals

Locking and Unlocking
Calls

Updates

Calls on Hold

Attachments

Saving

Closing

Stopwatch

Call Counter

Toolbars

Call Map

HEATBoard

This chapter explains the tools and processes of Call
Logging. It shows you how to launch Call Logging,
discusses each element of the Call Logging screen,

including how to customize your own toolbar, and defines
the terms used when logging a call.
You will learn how to create a new Call Record, log the
basic information of a call, and use the Detail, Assignment,
and Journal screens.
You will also learn how to assign a call to a technician and
how to use the Call Map feature to track overdue
assignments.
This chapter also shows you how to use the HEATBoard to
increase the visibility of critical issues.You can also send a
customized Information Query from Auto Ticket Generator
to Call Logging for specific Call Record information.
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Important Terms in Call Logging

HEAT

The HEAT Module. Call Logging is part of the HEAT Module.

Customer Type

Customer Type is a category in Call Logging that identifies a type of
customer.

� Organizations: Companies who are supported by the
support center.

� People: Customers or end users who are supported by the
support center.

� Equipment: Equipment supported by the support center.

Call Record (also called a Call Ticket)

A Call Record is information about a specific call. A new Call Record is
opened when a new call comes into the support center. A Call Record
contains Profile information, as well as information on the four Call
Logging tab screens: Call Log, Detail, Assignment and Journal.

The Profile Subset

The Profile Subset appears at the top of each Call Record and displays
selected customer information, such as company name and telephone
number of the caller.

Call ID Number

The Call ID Number is a unique system-generated number that
identifies each Call Record. HEAT assigns the Call ID Number when a
new Call Record is opened.

Customer Record

A Customer Record is a collection of information about a customer.

Customer ID

A Customer ID is a numeric or alpha-numeric combination that your
system administrator designs to uniquely identify customers. It ties all
of the elements of a Customer Record together and is the link between
the Customer Record and that customer�s Call Records.

Call Groups

The HEAT system displays Call Records in Call Groups. All Call
Records in a Call Group have similar characteristics. For example, if you
queried the HEAT system to show all Call Records that have an Open
Call Status, the result would be a group containing all the open records.
The Work Group is a special Call Group containing all the calls you
have created, modified or selected in the current HEAT session.

Hot Lists

A Hot List is a special kind of Call Group. The Call Records in a Hot
List do not necessarily have any common characteristics. Call Records
are manually added to a Hot List.

Validated Fields
When a field is validated, you can select information from a list of
values. If the information you want is not displayed, you can, in some
cases, type the appropriate information into the field. This is called
Helpful Validation. Not all fields are available for Helpful Validation.



CALL LOGGING  2-3

Launch Call Logging

Double-click the Call
Logging icon on your
desktop, or select
Programs>>HEAT>> Call
Logging from the Start
menu.

If the Select Data Source
dialog box appears, select a
data source.

Click OK.

Type your User ID and
Password. Note: The
password is case-sensitive.

Click OK.

4

Launching
Call Logging
To log into Call Logging, you
must have access rights. You
must also select a SQL data
source. See your system
administrator for access rights
and a data source.

5

3

1

2

1

2

3

4
5

6
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TIP
You can set a data source to load
automatically when you launch Call
Logging. Check the appropriate box
the first time you log on, or select
User Preferences>>Location from
the File menu.

SEE ALSO
Setting the Default Data Source in
�User Preferences,� Chapter 10.

Call Logging
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The Call Logging Screen
The main Call Logging screen has several parts, each with its own information areas and purpose. Your System Administrator
designs these screens, so your screen may differ from this example. The next eight pages show the different parts of the Call
Logging screen and explain their uses.

Profile
Subset
(page 6)

Call
Record
(page 7)

Status Bar
(page 13)

Call Map Tab
(page 11)

InfoCenter
(page 11)

Menu Bar
(page 5)

Toolbar
(page 5)

Call Status
Banner
(page 5)

HEATBoard Tab
(page 11)

Attachment Bar
(page 12)

Tabs
(pages 7-10)

Control
Buttons
(page 12)
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Menu,
Toolbar, and
Banner
The menu bar and the toolbar
are the main controls for using
HEAT. The Call Status Banner
displays information about the
current call in the current Call
Group.

Menu Bar

Toolbar

Call Status Banner

The toolbar buttons are shortcuts for
issuing common commands. To use a
toolbar button, click the button. This
chapter explains how to customize the
toolbar.

The Call ID is a unique reference number
for a Call Record, generated automatically
by HEAT.

The Stopwatch shows the elapsed time
since you have modified this Call Record.

The Call Counter tracks multiple calls of
identical items. Instead of creating
multiple Call Records for several calls
regarding the same problem, you can
increment the number in the Count area.

The status area shows whether the call
is open, closed, reopened, etc.

1 2 43

31

2

4

The Menu bar lists the commands you
use to work with HEAT. To open a menu,
click its name. To choose one of its
commands, click the command.
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The Profile
Subset
The Profile Subset appears at
the top of each Call Record.
The Profile is the background
information on a customer. The
Profile Subset is selected
information from the Profile
table, and is part of the Call
Record. In Call Logging, ID
numbers are associated with
each company, employee and
asset to identiry the  caller
each time a call is received. .
The SLA (Service Level
Agreement) Class indicates the
level of support your company
has committed to this person
or company. Your System
Administrator defines Service
Levels within your company.

Site ID

Employee  ID

Asset ID
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The Call Log
Tab
The Call Record appears
below the Profile Subset. In it,
you type information about
the call.
This screen holds information
about the specific call such as
Call Type, call description,
closure information, etc. It can
be validated and auto-filled
from a variety of different
tables.
If your system administrator
designs the Call Log area,
your screen will look different
from this example.
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The Detail Tab

The Detail screen displays
information specific to the
Call Type selected on the Call
Log tab.
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The
Assignment
Tab
From the Assignment tab, you
can assign the Call Record to a
technician or a group of
technicians. When you fill out
the Assignment form and save
it, the Call Record is assigned
to the designated technician or
group (upper picture).
Click the Grid/Form View

button  to see a grid view

of all assignments made for
this Call Record (lower
picture).

TIP
To print the grid, right click on the
grid and select print.
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The Journal
Tab
From the Journal tab, you can
write notes or other journal
entries pertaining to this Call
Record (upper picture).
Click the  Grid/Form View

button   to see a  grid view

of all journal entries made for
this Call Record (lower
picture).
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The
InfoCenter
The InfoCenter appears in a
pane next to the Call Record. It
contains two tabs: The Call
Map and the HEATBoard.
The Call Map is an
expandable and collapsible
summary view of the current
Call Record. The system
administrator determines
which fields appear in the Call
Map.
With the HEATBoard,
members of a team can post
and read issues from other
team members and receive
system-wide information.
SEE ALSO

The Call Map The HEATBoard

SEE ALSO
�Opening the Call Map� and
�Viewing Issues,� in this chapter.
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Tabs and
Control
Buttons
Near the bottom of the Call
Logging screen are several
control buttons. With these
buttons, you can navigate
among the call record
information areas and display
other information.

Click the Call Log, Detail, Assignment, or Journal tabs to display the information associated
with each tab.

The Lock button locks a call so that only you can work on the Call Record. The System
Administrator can also unlock the call. When the call is unlocked, the button has an unlocked
padlock icon. When the call is locked, the button has a key icon. When the call is locked by
someone else, the icon is a locked padlock.

The Grid View-Form View button lets you switch from an Assignment or Journal form to a grid
view of all Assignments or Journal entries.

The New button on the Assignment and Journal tabs let you create a new Journal entry or
Assignment. Click the Abandon button to abandon the current Journal or Assignment entry.
The System Administrator controls rights to add or abandon journal and assignment entries.

The Arrow keys let you scroll through different forms on the Assignment and Journal tabs.

Click the Display Activity Log to open the Activity Log, which shows all Activity Log entries for
the current call. An Activity Log shows any activity associated with a call, such as when the call
was handles and by whom.

Click the Display Call Transfer Log to open the Call Transfer Log, which shows if the call has
been transferred, and from where.

Display E-Mail Attachments displays mail attached to this call.

Click the Display Global Attachments to display any attachments stored in the HEAT database
that are accessible for any user on any call.

Click the Display Attachments Bar Menu to add, edit, or remove attachments associated with
the current Call Record.
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Status Bar
At the bottom of the Call
Logging screen is the Status
Bar. It displays the current
status of the Call Record.

The Status Field displays information about the current field.

The Validated Field icon indicates that the selected field requires data.

The Required Field icon indicates that the selected field must contain data.

The HEATBoard icon accesses the HEATBoard.

The Alarms icon indicates that alarms have fired when the alarm icon appears to be
ringing.

The SupportMail icon indicates that SupportMail has been delivered to your mail box
when the mail box flag is raised.

The Searching Field shows searching status and results.7
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Create a Call Record

Select New Call Record
from the File menu.

Select a Customer Type.
(This dialog box does not
appear after you log the first
call. It defaults to the
Customer Type of the last
Call Record created. To
select a new customer type,
select Customer Type from
the File menu, then select a
Customer Type.)

Click OK.

Right-click in a validated
field (generally the ID
Number field, such as
Company ID).

Select Validate Field.

Double-click a customer.
The Profile Subset fields are
auto-filled with the
customer�s information.

6

5

4

3

2

1
1

5

4

2
3

Creating Call
Records
A Call Record is a complete
record of a problem or service
request from a customer or
employee. Each Call Record is
linked to a Customer Record.
Some fields in a Call Record
are validated fields. Validated
information is linked to one or
more databases. When you
select validated information
for a field, HEAT auto-fills all
the other validated fields.
Using validated information
ensures accuracy when filling
out a form.
Your system administrator
may also set up fields that are
�helpfully validated.� Helpful
Validation lets you type new
information in a field if an
appropriate entry cannot be
found in the drop-down list.
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Fill out the Call
Record

Type a description of the
call.

Select the Call Type.

Select the call priority, if
necessary (it is generally
auto-filled based on Call
Type).

Select the owner, if
necessary (it defaults to the
User ID).

Select the source of the call
(it defaults to Phone).

Select Save Call Record
from the File menu.

TIP
Give the Call ID Number to the
customer to simplify subsequent
calls.
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Viewing Call
Details
Details of a Call Record
appear on the Detail Tab.
Before you must select a Call
Type for the current call.
Each Call Type may have a
different Detail Screen. The
fields in the Detail Screen vary
with the Call Type you select
in the Call Log screen. Not
every Call Type has a Detail
screen.
The Detail window is
customizable and will look a
little different from our
example.
Two Detail window examples
are shown on the right � one
is for a product issue, and the
other is for a manual request.

View Call Details

Click the Detail tab.

Example�Record
Software Details

Right-click in the Software
Name field.

Select Validate.

Choose the appropriate
product from the list.

Click OK.

Example�Manual
Request

Right-click in the Asset
field.

Select Validate Field.

Select a printer from the
list.
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Assigning Call
Records
Each Call Record may be
assigned to a person or group
that can solve it. A group has
several technicians with a
broad base of knowledge and
experience. One of its members
may specialize in solving the
current problem.
You can assign a Call Record
to more than one group or
technician.
Each assignment appears in
the Call Record.

Assign a Call Record

Click the Assignment tab.

Right-click the Assignment
screen.

Select New Assignment.

Select a group from the
Group drop-down box.

Type any comments or
instructions in the
Comments about
assignment field.

You may select an Assignee
from the Assignee drop-
down box. Data about the
Assignee automatically
appears.

To assign this Call Record to
another group or technician,
repeat steps 2-6.

TIP
You can create a new assignment
or abandon changes to the current
assignment with the buttons to the
right of the Journal tab.
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Abandoning
Assignments
Before you save an assignment
in a Call Record, you can
abandon the assignment.

Abandon an
Assignment

Before you save a new
Assignment, right-click the
Assignment screen.

Click Abandon Assignment.

Click Yes.TIP
You can create a new assignment
or abandon changes to the current
assignment with the buttons to the
right of the Journal tab.
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Viewing
Assignments
A Call Record can have
multiple assignments.
In grid view, you can view a
list of all assignments. Each
row in the grid represents one
assignment for the selected
Call Record. If you select an
assignment from the grid, it
appears in form view.

View Assignments

Click the Assignment tab.
Assignments for the Call
Record appear. (Assignments
are available if the tab has a
check mark.)

In the Form view, click the
right, left, first, or last arrow
buttons to page through
Assignments for this Call
Record.

In the Grid view, all
assignments for the Call
Record appear. Double-click
the Assignment you want to
view. The selected assignment
appears in form view.

1

2
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21

3

TIP
You can set the default view for
assignments under Grid Settings
in the User Preferences dialog box.



2-20   CALL LOGGING AT A GLANCE

Acknowledging
Assignments
When you receive an
assignment, your first step is
to acknowledge it. The
acknowledgment becomes part
of the Call Record.

Acknowledge an
Assignment

Click the Assignment tab on
a Call Record assigned to
you.

Right-click the Assignment
screen.

Click Acknowledge.TIP
Create and save a Call Group of all
Call Records assigned to you or
your department. Each time you
open or refresh that Call Group,
you will see all new Call Records
assigned to you.
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Resolving
Assignments
When you have resolved an
assignment, you can record the
resolution in the Call Record.
Resolving an assignment does
not close a Call Record.

Resolve an
Assignment

Click the Assignment tab on
a Call Record assigned to
you.

Select a Resolution Code
from the Resolution Code
drop-down box.

Right-click the Assignment
screen.

Click Resolve.4

3

2

1

2

1

3
4



2-22   CALL LOGGING AT A GLANCE

Documenting
Call Record
Actions
With the Journal, you can
record details about a
customer�s call, technician
actions on the call, and other
information. A single Call
Record can have multiple
journal entries.
From the Journal Entry screen,
you can open and view other
HEAT screens, and then return
to the Journal Entry screen.
You can paste information
from other sources into the
Journal. You can also paste
journal entries into other
fields.

Create a Journal
Entry

Click the Journal tab.

Right-click the Journal
screen.

Select New Journal Entry.

Type journal information in the
Journal Entry Fields.

4

3

2

1

4

1

3
2



CALL LOGGING  2-23

Check Spelling

Right-click the Journal
Entry screen.

Click Spell Check.

To select a suggested word,
highlight the correct
spelling in the Suggestions
list.

To replace the word with the
highlighted suggested word,
click Change.

To replace all instances of
the word with the highlighted
word, click Change All.

To ignore the word, click
Ignore.

To ignore all instances of the
word, click Ignore All.

To add the word to a custom
dictionary, select a
dictionary from the drop-
down box and click Add.

To select the options you
would like to use, click the
Options button.

4

Checking
Spelling in
Journal Entries
The Spell Check operates like
the spell check found in many
word processors. It displays
words that are not in its
dictionary. Often it suggests
replacement words.
You can select a replacement
word, ignore the word, or type
a new word.
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Abandon a Journal
Entry

Before you save a new Journal
entry, right-click the Journal
Entry screen.

Click Abandon Journal
Entry.

Click Yes.

Abandoning
Journal Entries
You can abandon a Journal
entry before you save it.

TIP
You can create a new journal or
abandon changes to the current
journal with the buttons to the
right of the Journal tab.
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Editing
Journal Entries
You can cut, copy, and paste
text in a Journal entry.

Copy or Cut Text
from the Journal

Highlight the text you want
to copy or cut.

Right click.

Select Copy or Cut.

2

Paste Text into the
Journal

Copy the information you
want to paste into the
Journal.

Click in the Journal Entry
screen at the point where
you want to paste the text.

Right click.

Select Paste.
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Viewing
Journal Entries
A Call Record can have
multiple Journal entries. You
can view Journal entries in
form view or in grid view.
In form view, each Journal
entry appears on a form. Use
the navigation buttons to
scroll through Journal entries.
In grid view, a grid displays a
list of all Journal entries. Each
row in the Grid represents one
Journal entry for the selected
Call Record.

View a Journal Entry

Click the Journal tab. The
current Journal entry appears
in the view selected in User
Preferences.

Click the first, previous,
next, or last buttons to page
through Journal entries for this
Call Record.

Click the Grid icon. All
Journal entries for the Call
Record appear in grid view.

Click the Journal entry you
want to view.

Click the Form icon. The
selected Journal entry
appears in form view.

TIP
You can set the default view for
journal entries under Grid
Settings in the User Preferences
Dialog Box. See �User
Preferences,� Chapter 10.
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Printing Grids

You can print the grids
displayed while you are in
Grid View.

Print a Grid

Right-click on the grid.

Select Print.

1

2
1 2

In addition, HEAT provides a
Grid Page Setup feature to set
the Headers, Footers and
Fonts that apply to the printed
document.

The following areas have Grid
Printing featues:

� Call Records in
Assignment and Journal
views.

� Records in Table
Maintenance

� Call Record Browse

Grid Page Setup
Select File>>Grid Page
Setup.

Enter the Header text.

Enter the Footer text.

Select the font, font style
and size.

Set the margins.

Select OK.
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Locking and
Unlocking Call
Records
When you lock a Call Record,
it is temporarily unavailable to
anyone else. Your system
administrator controls rights
to edit calls locked by other
users. A Call Record becomes
locked when modified and
unlocked when saved.

Lock a Call Record

Select Lock Call Record
from the File menu.

Unlock a Call Record

Select Unlock Call Record
from the File menu.

TIP
The symbol on the Lock-Unlock
button shows whether a call is
locked or unlocked.

The key shows your call is locked.
Clicking the button unlocks your
call.

The open lock shows your call is
unlocked. Clicking the button locks
the call.

The closed lock shows that the call
has been locked by someone else.
Hold the cursor over the button to
see who locked it, and when.
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Updating Call
Records
You can update any unlocked,
non-closed Call Record. If the
Call Record is closed, you may
reopen it before editing. (See
your system administrator.)
You can change most of the
information in a Call Record,
including the Customer ID and
Customer Type.

Update a Call
Record

Check the Locked-Unlocked
icon to make sure this Call
Record is unlocked.

Check the Status box to
make sure the call is not
closed. You may only update
open, unlocked calls.

Click the tab screen you want
to update.

Edit the fields you want to
update.

Click the Save button.
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Putting  Call
Records on
Hold
You can only work on one
unsaved Call Record at a time.
If you must open a new Call
Record before you save the
current Call Record, you can
put the current Call Record on
hold.
A Call Record on hold resides
in a Call Group called Calls on
Hold. It stays there until you
complete the Call Record and
save it.
If a system administrator
commits an edit set, all calls
on hold will be lost.

Put a Call Record on
Hold

Select Put Call on Hold
from the File menu.

Take a Call Record
Off of Hold

Select Calls on Hold from
the Group menu.

Select the Call Record you
want to take off hold.

Finish the required fields on
the call.

Save the call. It will be
removed from the Calls on
Hold group.

1

1

4

3

2

1

1



CALL LOGGING  2-31

Attaching
Files to Call
Records
You can attach one or more
files or applications to a Call
Record. You can also attach a
file globally to the system.
In order for others to view an
attachment, it must be in a
location that is shared by all,
for example, a folder on a
shared network directory.

Attach a File to a Call
Record

Click the Display
Attachment Bar Menu icon.

Click Add Attachment.

Type a description (this
appears in the Attachment
bar).

Click Browse to browse to
the path and file name of the
file, or type a file name or URL
into the File Name field.

Click OK.
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Editing
Attachments
You can edit the file names
and paths to attachments.

Edit an Attachment

Click the Display
Attachment Bar Menu
icon.

Click Edit Attachment. If
there is more than one
attachment, select the
attachment to edit.

Click Browse to browse to
the path and file name of the
file, or type the pathname of
the file in the File Name
field.

Click OK.4
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Removing
Attachments
You can remove attachments
from a Call Record.

Remove an
Attachment

Click the Display
Attachment Bar Menu icon.

Click Remove Attachment.

Select the attachment to be
deleted.

Click Remove.

Click Yes.
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Saving Call
Records
To enter a Call Record into the
database, you must save it.
You can save in several ways.
First, you can access the File
menu and select the save
option. You can click the Save
Call icon on the toolbar. If you
have not yet saved an open
Call Record and you attempt
to close HEAT, or open a
different Call Record, HEAT
will prompt you to save the
call.

Save a Call Record

Click the Save Call icon on
the toolbar.

Save a Call Record

With a Call Record open,
click New Call Record.

Click Save to save this call
and begin another operation.

Click Abandon to abandon
this Call Record without
saving it.

Click Put On Hold to put
this call on hold.

Click Cancel to return to the
current Call Record.
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Closing Call
Records
You can close a Call Record
when the problem is resolved
or otherwise becomes inactive.
If you have not completed
close-required fields for the
Call Record, HEAT will show
which fields must be
completed before the call can
be closed.

TIP
Don�t close a Call Record if you
think you may need to add more
information to it.

Close a Call Record

Complete the Close
Description information in the
Call Record.

You may enter a Cause in the
Cause field or select a Cause
from the validation table.

You may type notes about the
resolution of this problem in
the Solution field.

Click the Quick Close icon
on the toolbar.

Note: If you haven�t
completed the close required
fields, a dialog displays the
fields you must complete
before you can close the call.
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Using the
Stopwatch
The Call Logging screen has a
stopwatch in the Call Status
Banner. It records the time
spent on a Call Record.
Your system may be set up to
start the stopwatch when you
open a new Call Record, or
when you begin to enter
information into a Call Record.
The stopwatch stops when
you save, close, or abandon a
Call Record.
You can stop and restart the
stopwatch manually. You can
also change the time displayed
on the stopwatch.

Use the Stopwatch

To stop the stopwatch,
select Stopwatch>>Stop
from the Edit menu.

To start the stopwatch,
select Stopwatch>>Start
from the Edit menu.
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Change the
Stopwatch Time

Select Stopwatch>>Edit
from the Edit menu.

Type the new stopwatch time
in the field. Use the format
HHHH:MM:SS.

Click OK.

TIP
Your system administrator controls
rights to change the stopwatch.
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Resizing Grid
Column
Widths
HEAT retains resized grid
column widths in the
following areas of Call
Logging:

� Profile, Configuration,
and Call History grids in
the Customer window

� Table Maintenance

� Validation

� Assignment and Journal
Lists

� Call Record Browse

TIP

TIP
Use the Reset Column Widths
option to restore system defaults by
right-clicking on the grid and
selecting Reset Column Widths.

Resizing Column
Widths

1

1 Left click on the splitter bar
between columns.

2

2 Drag the splitter bar to the
new location.
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Using the Call
Counter
The Call Record screen has a
Call Counter in the Call Status
Banner. It records the number
of calls about the same
problem.

Change the Call
Counter

To increment the Call
Counter, select Counter>>
Increment from the Edit
menu.

To decrement the Call
Counter, select Counter>>
Decrement from the Edit
menu.

TIP
You can change the keys to
Increment or Decrement Call
Counting in User Preferences,
Detail Tab, Chapter 10.

SEE ALSO
Viewing Issues, in this chapter.
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TIP
 While the Call Counter records the
number of calls associated with an
issue, the HEATBoard can provide
specific information regarding the
issue, link associated calls, and be
team-based.
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Customizing
Toolbars
Your system administrator sets
up a default toolbar for each
role. When you launch Call
Logging, your role�s default
toolbar appears at the top of
the screen.
You can add tool buttons to a
toolbar. The system
administrator controls rights
to customize toolbars.

Add a Button to an
Existing Toolbar

Select Toolbar>> Customize
from the Edit menu.

Select a button category.

Drag a tool button from the
Commands field to the toolbar.

Click Close.

New Toolbar
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TIP
You can also customize toolbars from
the Customer, Table Maintenance
and Validation Update windows.
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TIP
You can remove buttons from a
toolbar. The system administrator
controls rights to customize
toolbars.

Remove a Button
from a Toolbar

Select Toolbar>>
Customize from the Edit
menu.

Drag the unwanted button
off the toolbar and release it.

Click Close.

New Toolbar
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Creating
Toolbars
You can add other toolbars to
the Call Logging screen.
When a new toolbar is created,
it is empty until buttons are
added to it.

Create a Toolbar

Select Toolbar>>
Customize from the Edit
menu.

Click Toolbars.

Click New.

Type a name for the toolbar.

Click OK. The new toolbar
appears.

To add buttons to the new
toolbar, see the next page.

New
Toolbar
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Add a Button to the
New Toolbar

Select a button category.

Select a button from the
Commands field.

Drag the button onto the
toolbar.

Repeat steps 1 through 3 for
each button.

To delete a button from a
toolbar, click and drag the
button off the toolbar.

Click Close.

TIP
You can add buttons from different
categories.
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Resizing and
Moving
Toolbars
You can resize and move
toolbars. A toolbar can be a
vertical or horizontal band, or
a square. It can float, or it can
dock on any side of the screen
(top, bottom, left, right).

Resize and Move a
Toolbar

Move the cursor over the edge
of the toolbar until the double
arrow appears.

Drag the edge of the toolbar
until it is the desired size.

To move the floating toolbar,
click in the blue title bar and
drag the toolbar to the new
location.

If the toolbar is docked, click
on the grab-handles (the
double gray bars) located on
the end of the toolbar; then
drag to a new position.
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Renaming
Toolbars
You can rename any toolbar
that you create. You cannot
rename the default toolbar.

Rename a Toolbar

Select Toolbar>> Customize
from the Edit menu.

Click Toolbars.

Click the toolbar to rename.

Click Rename.

Enter a new toolbar name.

Click OK.

Click Close.
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Deleting
Toolbars
You can delete any toolbar you
have created. You cannot
delete the default toolbar.

Delete a Toolbar

Select Toolbar>>
Customize from the Edit
menu.

Click Toolbars.

Select the toolbar to delete.

Click Delete.

Click OK.

Click Close.
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Resetting and
Restoring
Toolbars
If you modify your role�s
default toolbar, you can reset it
to its default setting.
If you modify a personal
toolbar, you can restore it to its
setting from the last time the
toolbar was saved.

Reset the Toolbar

Select Toolbar>> Reset to
Default from the Edit
menu.

Restore the Toolbar

Select Toolbar>> Restore
Personal from the Edit
menu.

TIP
The toolbar setup is saved when
you exit from Call Logging.
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Loading and
Saving Your
Role�s Toolbar
Your system administrator
assigns a default toolbar to
each role. If you have the
appropriate rights, you can
load and save this default
toolbar.

Load the Toolbar

Select Toolbar>> Load
Security Role Default from
the Edit menu.

Choose a security role from
the drop-down list.

Click Save as my personal
toolbar.

Click OK.

Save the Toolbar

Select Toolbar>> Save
Security Role Default from
the Edit menu.

Choose a security role from
the drop-down list.

Click OK.
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Opening the
Call Map
The Call Map gives you a
quick overview of the currently
displayed Call Record. It
displays information about
calls, customers, journals,
assignments, etc. Looking at
the Call Map you can quickly
view overdue assignments,
call status, current assignee,
etc. What you can view is
based on your security rights.
The Administrator Module
defines the fields displayed on
your Call Map.
Specialized icons highlight
key information that requires
attention such as past due
dates.
The number of journals and
assignments can be included
in the display of those nodes.
When opened, the Call Map
becomes an additional pane
on your Call Logging Window.
It can be displayed as  hidden
or moved, depending on your
personal preference.

Open the Call Map

Select InfoCenter>>Go to
Call Map from the View
menu.

To resize the Call Map, click
and drag the edge of the
pane.

To close the Call Map, click
the X at the top right corner
of the pane.

To move the Call Map, click
on the grab-handle (double-
bar) at the top of the Call
Map, then drag it to its new
location.
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Expand or Collapse
the Information Tree

To expand or collapse an
information tree, click the plus
or minus. The example shows
branches of the information
tree completely expanded.

If an icon has a + beside it, it
contains information. You can
expand the information and
view the Call Record�s
contents in detail by clicking
on the +.

When an information branch
has been expanded, its icon
has a - beside it. Click the - to
collapse the branch.

Double-click an icon to take
you to that area of the Call
Record.

Using the Call
Map
The Call Map displays a high-
level view of the currently
displayed Call Record. Call
data is displayed in an
information tree.
Your system administrator
determines which fields
appear in the Call Map. For
example, the Call Map can
notify you if assignments are
acknowledged, resolved or
overdue.

1 2
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2



CALL LOGGING  2-51

Opening
HEATBoard
The HEATBoard is used to
post important issues that
might generate a number of
calls. For example, when
defective part has been
shipped, several customers
will call the Support Center.
When a problem is reported,
an issue  can be posted to alert
the support center. All calls
related to the issue can then be
�linked� to the issue.
The HEATBoard is team-
based�issues can be specified
for global viewing or team
viewing. Depending on how
the HEATBoard is defined in
User Preferences, each team
can be represented on the
HEATBoard by a bar. A bar
labeled �Global� displays
issues posted for global
viewing. An envelope icon on
a team bar indicates that
issues have been posted for
that team. Only team members
can view issues for that team,
but all users with HEATBoard
access can view Global team
issues, depending upon their
security rights.

Open HEATBoard

Select InfoCenter>>Go To
HEATBoard from the View
menu, or click the
HEATBoard tab.

To resize the HEATBoard,
click and drag the edge of
the pane.

To close HEATBoard, click
the X at the top right corner
of the pane.

To move the HEATBoard,
click on the grab-handle
(double-bar) at the top of the
HEATBoard, then drag it to
its new location.
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Global Category Bar

Using
HEATBoard
Controls
HEATBoard has several
category bars, buttons, and
links. This page explains their
functions.
� New HEATBoard Issue creates

an issue.
� HEATBoard Issue Details

opens the highlighted issue.

� Link Current Call links the
current Call Record to the
highlighted issue. A call can be
linked to only one HEATBoard
issue.

� Open Group opens the group
of calls linked to the
highlighted issue.

� AutoClose closes all calls
linked to the issue when it is
resolved.

� Team Category Bars display
issues for a specific team.

� Global Category Bar displays
global issues.

� Open Envelope icon indicates
the issue has been read. A
Closed Envelope icon indicates
the issue has not been read.

� Push Pin icon indicates calls
are linked to the issue.

View HEATBoard

Envelope Icon

AutoClose

Open Group
Link Current Call

Push Pin
Icon

HEATBoard
Issue Details

New HEATBoard
Issue

HEATBoard Issues

Team
Category
Bars
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Viewing
Issues
The HEATBoard is team-
based. It can display issues
that are available for your
team or the global audience.
A closed envelope indicates
there are new, unread issues
posted.
An open envelope icon on a
team category bar indicates
there is an open issue for the
team.

View an Issue

To view issues posted by
your team, click a Team
tab. To view issues posted
globally, click the Global
tab.

To view issue details,
double-click the issue.
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Creating New
Issues
Issues that might affect a
number of users should be
posted immediately to the
HEATBoard to alert other
technicians about the problem
and also let them link all
related calls to the issue.
For example, if a defective part
ships, a new issue can be
created that includes a
description of the problem,
such as �defective stitching on
gadget...� Because the entire
support center should know
about the issue, it is marked
for �Global� viewing.

Create a New Issue

Click the New HEATBoard
Issue button on the
HEATBoard toolbar.

Type a description of the
issue in the Text field.

Select a view. The view is the
audience who can view this
issue. If you select Team,
select a team from the drop-
down box.

Mark Allow linked calls to
link calls to this issue.

If you choose not to Allow
Linked Calls, you can select
an expiration time and date for
this issue.

Click OK.6
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Editing Issues
After an issue is created on the
HEATBoard, it can be edited
when information needs to be
added or deleted.

Edit a Issue

Double-click an issue on
the HEATBoard.

Click Edit.

Edit any active fields.

Click OK.
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2

Link a Call From the
Toolbar

Select the issue from the
HEATBoard.

Click the Link Current Call
button on the HEATBoard
toolbar.

Click Allow this call to be
AutoClosed if you want to
AutoClose this call when the
issue is resolved.

Click OK.

Link a Call From the
Issue Dialog Box

Double-click an issue on the
HEATBoard.

Click Link Current Call.

Click Allow this call to be
AutoClosed if you want to
AutoClose this call when the
issue is resolved.

Click OK.

Linking Calls
Often a series of calls are
received about the same issue.
These calls can be grouped on
the HEATBoard and linked to
the issue. Calls linked to an
issue can be opened in a
group and AutoClosed when
the issue is resolved.
Linking a call makes it easy to
keep track of all calls related to
the same issue, as well as
close the call when the
problem is resolved.
A call can be linked to only
one issue.
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Unlink a Call

Right-click on an issue from
the HEATBoard.

Select Unlink current call.

Click OK.

Unlinking a
Call
You can unlink a call if it was
linked by mistake.
Before you attempt to unlink,
the call you want to unlink
must be the currently
displayed call.
SEE ALSO
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Setting the
Lead Call
When a number of calls are
linked to the same issue, you
can set a Lead Call.
The first call linked to the
issue is automatically
designated as the Lead Call.
You can, also, designate a
different call in the issue
group as the lead call.
A Lead Call acts as the single
point of information for the
issue, as well as a repository
for new information. Any
information about the issue
should be entered into the
Lead Call.
Some issues may have a
number of linked calls. Using
the Lead Call as your source of
information lets you quickly
enter closing information,
copy it to linked calls and
close the calls in the group. If
you randomly enter
information into any call in
the group, you may not be able
to locate that information
quickly.

Set the Lead Call
from the Menu

Right-click on an issue from
the HEATBoard.

Select Set Lead Call.

Click OK. The currently
displayed call is now
designated as the lead call.

Set the Lead Call
from the Issue Dialog
Box

Double-click an issue on the
HEATBoard.

Click Set Lead Call.

Click OK. The currently
displayed call is now
designated as the lead call.

TIP
When you open the group of linked
calls, the lead call is automatically
selected.
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Open an Issue
Group from the
Menu

Right-click on an issue from
the HEATBoard.

Select Open Group.

Open an Issue
Group from the
Toolbar

Select an issue from the
HEATBoard.

Click the Open Group
button.

Opening an
Issue Group
Calls linked to an issue on the
HEATBoard are grouped
together. You can open a group
to review the calls, add
additional information, or
AutoClose the group when the
issue is resolved.
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AutoClosing
Calls
After an issue is resolved, all
the calls linked to the issue
can be AutoClosed. This lets
you close all calls for this issue
in one step.
Calls must be marked as
available for AutoClosing
when they are linked to the
issue. If you did not select the
�Allow this call to be
AutoClosed� check box when
the call was linked to the
issue, it is not available for
AutoClosing . You must
manually close the call.

AutoClose a Call
Group from the
Toolbar

Select an issue from the
HEATBoard.

Click the AutoClose button.

SEE ALSO
Linking a Call, in this chapter.

AutoClose a Call
Group from the Menu

Right-click on an issue from
the HEATBoard.

Select AutoClose linked
calls.
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Customer
Records

IN THIS CHAPTER

Viewing Customer
Records

Profile Records

Contacts Records

Configuration Records

Call History

Customer Records contain information about
customers, work environments, call histories, and
other details. Call Logging gives you an overview of

the records and access to their details.
Customer Records are made up of four records: Profile,
Contacts, Configuration, and Call History.
� Profile � Profile records contain background information

about your customers, such as Company Name, Contact
Name, Phone Number, and Address.

� Contacts �Contact records contain a list of contacts
associated with your customer.

� Configuration � Configuration records contain information
about the equipment and software each customer uses.

� Call History � Call History displays a list of the support
center calls your customer has made.

This section discusses these records and explains how to
view, create, edit, and delete Customer Records.
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Viewing Customer Records
The four  Call Logging Customer Records are Profile,
Contacts, Configuration, and Call History.  A tab contains
information if a check mark appears on it. To view any of
these records from a Call Record, select Profile, Contacts,
Configuration, or Call History from the Customer menu.

Each Customer Record has Profile, Contacts, Configuration,
or Call History tab along the bottom of the screen. To view the
records, click the appropriate tab. The information may
appear as a form (form view) or a list (grid view). To change

the view, click the Grid View-Form View button  in the

lower left corner of the screen.

Profile Tab, Form View

Configuration Tab, Grid View

Call History Tab, Grid View
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Profile Subset

Profile Records
The Profile Record
A Profile Record contains all relevant information about a
customer or employee, such as name, telephone number,
location, e-mail address, and notes. You may edit Profile
information at any time. Your system administrator controls
the rights to edit this information.

The Profile Subset
The top portion of a Call Record is called the Profile Subset.
The Profile Subset displays selected customer information,
such as company name, contact, and telephone number of
the caller. The System Administrator selects the information
to be displayed. The Profile Subset remains displayed when
you switch tabs to Call Log, Detail, Assignment, or Journal.

Profile Record
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Creating
Profile
Records
You must create a Profile
Record for each new customer
or employee. You will use this
Profile Record for all
subsequent calls from this
customer.
Your system administrator
controls security rights to
create Profile Records.

Create a Profile
Record

Select Profile from the
Customer menu.

Select New from the Record
menu.

Select the Customer Type.

Click OK.

Fill in each field of the Profile
Record.

Click the Save Record icon.TIP

A lightning bolt icon  on the

Status Bar identifies a field that
must be filled in.
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Editing Profile
Records
When a customer�s data
changes, you will want to edit
the customer�s Profile Record.
Your system administrator
controls security rights to edit
Profile Records.

Edit a Profile Record

Select Profile from the
Customer menu.

Edit the Profile Record.

Click the Save icon.
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Deleting
Profile
Records
If your support center no
longer requires a customer
profile in the database, you
can delete it (depending on
your security rights).
Deleting a customer profile
cannot be reversed.
Information in a Profile Record
may be linked to other records
in your HEAT database. Not
all users have security rights
to delete customer profiles.
Always get permission from
your system administrator
before you delete a Profile
Record.
Be sure not to delete the Profile
Record of an open Call Record.
Your system administrator
controls security rights to
delete Profile Records.

Delete a Profile
Record

Close all open Call Groups.

Select Profile from the
Customer menu.

Select the Customer Type.

Select the Profile Record to
delete.

Select Delete from the
Record menu.

Click Yes.
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Contact Records
The Contact Records displays a list of contacts associated
with a particular customer. You can use this information to
monitor and organize contacts more efficiently.

Note: The Customer Type must be associated with a Contact
Table before the contact information can be viewed. If an
external Contact Table is being used, information can be
edited and added, but not deleted. See your system
administrator for more information.

Contact Record (Grid View)

Contact Record (Form View)
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Viewing
Contact
Records
You can view all contact
information available for a
particular customer. This
option is only available if your
system administrator has
associated your particular
Customer Type with a Contact
Table.

View the Current
Customer�s Contact
Records

Select Contacts from the
Customer menu.

Double-click the record you
want to view.

Contact Record
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Adding
Contact
Records
You can add new contacts
associated with a particular
customer.

Add a Contact
Record

Select Contacts from the
Customer menu.

Select New from the Record
menu in the Customer
Window.

Type the appropriate
information in the Contacts
form.

Click the Save icon.

Click File>>Close to close
the record.
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Editing
Contact
Records
You can update contacts
associated with a particular
customer by editing the
Contact Records.

Edit a Contact
Record

Select Contacts from the
Customer menu.

Double-click the record you
want to edit.

Edit the record.

Click the Save icon.

Click File>>Close to close
the record.
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Deleting
Contact
Records
If a record associated with a
customer is no longer valid,
you can delete it from the
Contact Records.

Delete a Contact
Record

Select Contacts from the
Customer menu.

Select the record you want to
delete.

Select Delete from the
Record menu.

Click Yes.

Click File>>Close to close
the record.
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Configuration Records
Configuration Records contain information about a
customer�s environment configuration. The records appear as
rows in a Configuration Table.
A Configuration Table contains one or more Configuration
Records. Each element in the customer�s environment
appears as a record in the Configuration Table. With the
information in this table you can track each element of your
customer�s system.

Configuration Record (Grid View)

Configuration Record (Form View)
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Viewing
Configuration
Records
When  customers call about
problems,  use the customers�
Configuration Records to view
details about their system.

View Configurations
for the Current Call
Record

Select Configuration from
the Customer menu.

Highlight the record you want
to view.

Click the Form View icon.

Configuration Record
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Adding
Configuration
Records
When a customer adds a
computer, printer, peripheral,
software application, or other
component to the system, you
will want to add a Configura-
tion Record for it.

Add a Configuration
Record

Select Configuration from
the Customer menu.

Select New from the
Record menu.

Select a Configuration
Type.

Click OK.

Type the appropriate
information in the
Configuration form. Each
form is different and requires
different information.

Click the Save icon.

Select File>>Close to
close the record.
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Editing
Configuration
Records
You can revise information
about a customer�s system by
editing the Configuration
Record.

Edit a Configuration
Record

Select Configuration from
the Customer menu.

Double-click the record you
want to edit.

Edit the record.

Click the Save icon.

Select File>>Close.
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Copying and
Moving
Configuration
Records
You can copy and move
Configuration Records as
equipment is moved in or out
for repair.
You can move records when a
customer transfers parts of a
system to a different
department or different
customer. You can copy
records if more than one
department or customer shares
an element.

Copy or Move a
Configuration Record

Select Asset Config Window
from the Accessory menu.
Configuration information from
the open Call Record appears
in the Accessory
Configuration Maintenance
form.

From the View menu, select
Transfer Mode or select the
Transfer Asset Info icon from
the toolbar.

Select the Customer who will
provide or receive the
transferred elements.

In one of the tables, highlight
the Record to be copied to the
other table.

Click Copy â or Copy á to
copy the record to the other
table,

or,

Click Moveâ or Moveá to
move the record to the other
table.

Select File>>Exit.

TIP
Customer Type 1 is the open Call
Record customer and can provide or
receive the transferred element.
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Deleting
Configuration
Records
If a customer removes an
element of the system, you can
remove the element�s
Configuration Record.

Delete a
Configuration Record

Select Configuration from
the Customer menu.

Select the record you want to
delete.

Select  Delete from the
Record menu.

Click Yes.

Select File>>Close.
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Creating a
call for an
asset 1

2
You can create a call for the
customer who owns the
current asset from the Asset
Config Window>>Record
menu.
This creates a call for the
customer who owns the
current asset and transfers the
asset�s information to the new
call record.

Create a call for a
current asset

Select Asset Config
Window from the
Accessory menu.

Select the asset record to
create a call record for.

Select Create Call for
Asset from the Record menu
to open the Call Record.
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Transferring
Asset
Information
to the
Current Call
Record

You can transfer an asset�s
information to the current Call
Record.

Transfer Asset
Information to the
Current Call Record

Select Asset Config
Maintenance from the
Accessory Menu.

Select the Asset Record
you would like to transfer.

Select Transfer Asset Info
from the Record menu.
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Call History
The Call History Record displays all Call Records for the
customer. You can use this information to determine if the
customer�s call has a Call Record or requires a new one. The
information shows how often the customer calls and the
kinds of calls the customer makes.

Call History (Grid View)
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Viewing Call
History
You can view a customer�s
Call History before you create
a Call Record. The current call
may already exist on a Call
Record.
You can also find out what
types of calls the customer
makes and if this problem has
occurred previously.

View the Current
Customer�s Call
History

Select Call History from the
Customer menu.

Double-click the Call Record
you want to view.

Selected Call Record

TIP
You can view a customer�s Call
History before creating a new call.
Select Customer>>Search, enter
profile criteria and select Search.
Next, select the Call History tab.
From there, a call may be selected
by double-clicking on the record or
a new call can be created by
clicking on the New Call icon.
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Call
Groups

IN THIS CHAPTER

About Call Groups

Opening Call Groups or
Hot Lists

Calls on Hold

Boolean Searches

Creating Call Groups

Editing Call Groups

Editing Boolean Searches

Saving Call Groups

Deleting Call Groups

Creating Hot Lists

Adding to Hot Lists

Opening Hot Lists

Editing Hot Lists

Deleting Hot Lists

Removing Calls From Hot
Lists

A Call Group is a collection of Call Records that may
or may not have similarities. A typical Call Group
has calls that have one or more things in common.

For example, let�s assume that you want to see all the Open
Call Records that are for defective parts. You can easily
create a Call Group that has only Open Calls with a call
type of �Product Issue.�
Another type of Call Group is a Hot List. It contains calls
that have been manually grouped together. A Hot List is a
collection of Call Records that may not have any
similarities. You can create a hot list and manually add
any number or type of calls you wish. Hot Lists can be
created for personal, team, or global viewing.
A Call Group can include one or more calls, and you can
create as may Call Groups as you wish. You can view or
work with the Call Records within a Call Group, search
through them for various characteristics, and run reports
or AutoTask actions against them.
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About Call Groups
A Call Group is a collection of Call Records. You can have as
many Call Groups as you want. All the data at your disposal
resides in the open Call Group. You can view or work with
these Call Records, search through them for various
characteristics, and run AutoTask actions against them.

Predefined Call Groups
The Demo database contains several predefined Call Groups
that you can use or modify. Examples include:

� All Calls
� All Active Calls
� Open Calls for Type

Work Group contains all Call Records you have created,
modified or opened during your current working session.
Use Work Group for quick access to your current work
session�s Call Records.
Calls on Hold contains all unsaved Call Records you have
placed on hold. HEAT creates this Call Group when you put
a Call Record on hold. When you save a Call Record, it is
removed from Calls on Hold.

Creating Call Groups
You can create a Call Group to contain all Call Records that
share one or more common features. Carefully created Call
Groups can help you work more efficiently. For example, you
can group your unacknowledged calls together, or make a
group of all calls from a certain customer.

Hot Lists
A Hot List is a special type of call group. Calls in a typical
Call Group have similarities such as call type or call status,
but a Hot List is a collection of unrelated calls that are
manually added. You can include any call type or number of
calls you wish.
Every user has a personal hot list called �My Hot List,�
available only to that user. To use My Hot List,  add calls to
My Hot List. You might want to use My Hot List as a �To Do�
list that includes any calls you need to work on that day.
You can also create other personal Hot Lists that are
accessible only to you, or create Hot Lists that can be shared
among teams or globally. Some Hot Lists may be restricted to
specific teams. For example, you can create a Supervisor Hot
List that can only be accessed by the Supervisor team
members.

Using Call Groups
What can you do with Call Groups?

� Schedule your work to make sure it gets completed on
time.

� Organize your work by priority to make sure the most
important tasks get done first.

� Track your work according to various criteria.
� Alert you to new calls, calls from important customers,

or return calls.
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Open a Call Group
or Hot List

Select Open Call Group
from the Group menu.

Select the view containing
the Call Group you want.

� The Personal view displays
your personal Call Groups
and Hot Lists.

� The Team view displays
Call Groups and Hot Lists
for the selected Team.

� The Global view displays all
Global Call Groups and Hot
Lists.

� The All view displays all
Call Groups and Hot Lists
available to you from the
personal and global views
and from your primary team.

If you select the Team view,
select a Team from the drop-
down list.

Select a Call Group.

Click Open.

Opening Call
Groups or Hot
Lists
Call Groups and Hot Lists are
saved to a view. The �view� is
the audience who can access
the Call Group or Hot List.
When you select a view, the
window displays all the Call
Groups and Hot Lists
contained in the view.
The icon next to the Hot List
indicates the view defined for
the Hot List.

Personal View:
Available to you only.

Team View:  Available to
a specific team.

Global View:  Available
for  global viewing.
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Using the
Calls on Hold
Call Group
You can put a Call Record on
hold when you have not saved
the Call and you want to
create another Call Record.
The Calls on Hold Call Group
is created when you put a Call
Record on hold. You can
access Calls on Hold from the
Group menu.
A Call Record on hold is not
saved in the database. If the
System Administrator commits
an edit set, you will lose all
Call Records on hold.

Put a Call Record on
Hold

Select Put Call on Hold
from the File menu.

Open the Call Group,
Calls on Hold

Select Calls on Hold from
the Group menu.

TIP
A Call can be put on hold, even if all
of the required information has not
been entered.

1

1

1

1



CALL GROUPS   4-5

Creating Call
Groups from a
Boolean
Search
You can create a call group
from Boolean Search results. A
Boolean Search is different
from a Simple Search because
Boolean Searching lets you use
more than one condition.
For example, with a Boolean
Search you can locate all
records that all meet the
following criteria:

� Call Record must be Open,
AND

� Call Record must have
�hardware� as the call
type, AND

� Call Record must have
�Chris� as the tracker.

If a call record does not meet
ALL of the above criteria, it is
not added to the group.
The results of a Boolean Search
can be converted into a Call
Group.

Create a Call Group
from a Boolean
Search

Select New Call Group
from the Group menu.

Type a name for the group.

Type a description for the
group.

Choose a view from the
Save to View box.

Select a table or @function
from the Table Name drop-
down list. (The Table Name
List includes the tables in
Call Logging as well as the
@function.)

Choose a Table Type. (This
field is available only if you
selected a Detail, Profile or
Subset table in step 5.

Click the Fields From All
Table Types check box (if
available) to include all the
fields from all the available
table types in your search
criteria.

Go to next page.

SEE ALSO
Boolean Search, Chapter 5 and
@Functions, Chapter 8 and
Appendix C.

1

7

6

5

4

3

2

1

3
2

4

7
6

5

8



4-6   CALL LOGGING AT A GLANCE

Double-click a field in the
Field Text box. This
becomes the first part of the
Boolean expression.

Double-click an operator in
the Operators list.

Click Browse Field Data.

Choose a value from the list
(you can also type your own
value into the Expression
box).

Click Select.

Click Check to verify that
your expression text is
correct.

Click Run or add multiple
conditions as described on
the next page.

SEE ALSO
Boolean Search, Chapter 5.
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SEE ALSO
Boolean Search, Chapter 5.

Click AND to add another
statement. For example,
CallLog.CallStatus=�Open�
AND CallLog.
CallType=�Hardware�

Click OR to add a varying
statement. For example,
CallLog.CallStatus=
�Reopened� OR CallLog.
CallStatus=�Open�

Click Order By.

Double-click one or more
names from the Field List.

Select Ascending or
Descending order.

Click OK.

Click Save and Run.
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Creating Call
Groups From a
Simple Search
A Simple Search is a query
based on one condition. For
example, you can search for all
the open Call Records.
To run a Simple Search, select
your query from a list of
predefined queries. Your
system administrator sets up
the predefined queries. When
you search within the group,
the group is �narrowed�
because HEAT looks for the
search criteria and closes any
other records that do not meet
the criteria.
After running a Simple Search,
the query results are a Call
Group. HEAT searches within
the selected Call Group for
your new criteria and creates a
new Call Group from the query
results. The group you selected
to search is retained.

Create a Call Group
from a Simple Search

Select Simple Search from
the Group menu.

Choose a search criteria.

Select an Operator from the
drop-down list.

Enter a value in the value
field or click Browse to
display a list of available
values.

Click Narrow an open call
group to search within a
specific group.

Select the search group
from the drop-down list.

Click Create a new call
group to create a call group
from the search results.

Click Run.
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SEE ALSO
Simple Search, Chapter 5.
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Editing Call
Groups
You can edit a Call Group�s
criteria. The editing screen
displays the criteria set up
when the Call Group was
created. You can change the
data in any field, or create a
new Boolean Search.

Select a Call Group
to Edit

To edit the displayed Call
Group, select Edit Group
Criteria from the Group
menu.

To edit a closed Call Group,
select Open Call Group
from the Group menu.

Highlight a Call Group to
edit.

Click Edit.
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Edit Call Group
Criteria

To change the Call Group
name, type a new name in
the Name field.

To change the Call Group
description, type a new
description in the
Description field.

To save the Call Group in a
different view, select a new
view in the Save To View
box.

Click Save.

TIP
You can edit Call Groups only if
you have the appropriate security
rights.

4

3

2

1
3

1
2 4



CALL GROUPS   4-11

Edit a Boolean
Search

Highlight the expression text
to be edited.

From your keyboard, press
Delete.

Select a table name.

Double-click a field text.

Double-click an operator.

Click Browse Field Data if
available.

Double-click field data.

Click AND to add another
statement. For example,
CallLog.CallStatus=�Open�
AND CallLog.
CallType=�Hardware�

Click OR to add a varying
statement. For example,
CallLog.CallStatus=
�Reopened� OR CallLog.
CallStatus=�Open�

Click Save.

TIP
Use the Edit feature to change one
or two details. Edit should not be
used to replace all the criteria.

Editing
Boolean
Searches
You can edit a Call Group�s
Boolean Search criteria, which
was set up when the Call
Group was created.

7

10

9

8

7

6

5

4

3

2

1

10

9

5
3

4

1

8
6



4-12   CALL LOGGING AT A GLANCE

Save New Search
Criteria to a New Call
Group

Select Save Criteria As
from the Group menu in an
open Call Group.

Type the new name.

Edit the description, if
necessary.

Click a view where you want
to save this file.

� The Personal view is
accessible to you only.

� The Team view is accessible
only to members of the
specified team.

� The Global view is
accessible to all HEAT
users.

If you select the Team view,
select a team from the drop-
down list.

Click OK.

Saving New
Search Criteria
to New Call
Groups
You can change the search
criteria of a Call Group, then
save the new criteria as a new
Call Group. This feature
creates a copy of an existing
Call Group. The original Call
Group is not deleted.

TIP
You can save a task in a personal
view, a team view for a team to
which you belong, or a global view.
You can see all of these views by
clicking �All,� but you cannot save
to the �All� view.
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Delete a Call Group

Select Open Call Group
from the Group menu.

Highlight a Call Group to
delete.

Click Delete.

Click Yes.

Click Close.

Deleting Call
Groups
You can delete Call Groups,
depending upon your security
rights.
Use caution when deleting a
Call Group. Once it is deleted,
a Call Group cannot be
restored.
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Creating Hot
Lists
A Hot List is a special type of
call group. While typical call
groups have similarities such
as call type or call status, a Hot
List is a collection of unrelated
calls that are manually added.
You can include any call type
or number of calls you wish.
The calls do not need to have
any similarities.
A personal Hot List called �My
Hot List� is already set up on
your system. All you need to
do is add calls to it.
You can also create new Hot
Lists for personal use or for
viewing by specific teams or
the global audience.

Create a Hot List
from the Menu

Select Add Call to Hot
List>>New Hot List from the
Group menu.

Type a name for the new
Hot List.

Type a description for the
new Hot List.

Click the view where you
want to save this Hot List.

� Personal View:  The Hot
List is accessible to you
only.

� Team View: The Hot List
can be viewed by members
of the specified team.

� Global View:  The Hot List
can be viewed by any GMSS
user with Hot List access.

If you select Team, select a
team from the drop-down
box.

Click OK.6
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Create a Hot List
from the Open Call
Group Dialog Box

Select Open Call Group
from the Group menu.

Click New Hot List.

Enter a name for the Hot List
in the Name field.

Enter a description for the
Hot List in the Description
field.

Select the view where you
want the Hot List stored. If
you select Team, choose a
team from the drop-down list.

Click OK.

Click OK. The Hot List is
created but cannot be
opened until you add calls
to it.

Click Close.

TIP
You can use My Hot List or create
your own Hot Lists, depending on
your security rights. You can
create any number of Hot Lists,
depending on the size of your
database.

5

SEE ALSO
About Call Groups, in this chapter.
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Adding Call
Records to My
Hot List
My Hot List is your personal
group of calls. For example,
you might want to create a
�Top 5� issues list to use as a
To Do list for the day.
Any number or type of calls
can be added to My Hot List.
Use these steps to add the
currently displayed call to My
Hot List.

Add a Call Record to
My Hot List

Select Add Call to My Hot
List from the Group menu.

Click OK.2
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Add a Call Record to
Another Hot List

Select Add Call to Hot List
from the Group menu.

Select a hot list.

Click OK.

Adding Call
Records to
Other Hot Lists
You can add the currently
displayed Call Record to any
Hot List you can access. 3
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Opening  My
Hot List
My Hot List is for your use
only. It is already set up on
your system; all you need to do
is add calls to it.
There are different ways to use
My Hot List. You might want
to use it as a To Do list. It can
include all the calls you need
to work on today. Or you could
use My Hot List to include
Call Records for a research
project.

Open My Hot List

Select My Hot List from the
Group menu. If no calls have
been added yet, a message
appears, stating �0 call
records found.�
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Editing Hot
Lists
You can change the name,
description or view location of
a Hot List at any time. There
are two ways to edit a Hot List:
through the Open Call Group
dialog box and through the
Edit Group Criteria dialog box.
SEE ALSO

Edit a Hot List

Select Open Call Group
from the Group menu.

Select the view where the
Hot List is stored.

Select a Hot List.

Click Edit.

Edit the name, description,
or view location.

Click OK.

Click Close.
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Editing a Call Group, in this
chapter.
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Deleting Hot
Lists
You can delete a Hot List. This
procedure cannot be reversed.
Your system administrator
controls rights to delete Hot
Lists.
You cannot delete My Hot List.

Delete a Hot List

Select Open Call Group
from the Group menu.

Select the view containing
the Hot List you want to
delete.

Select a Hot List to delete.

Click Delete.

Click Yes.

Click Close.6
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Removing Call
Records from
Hot Lists
You can remove the currently
displayed Call Record from
the open Hot List. You cannot
undo a deletion. Your system
administrator controls rights
to remove records from Hot
Lists.

Remove a Call
Record from a Hot
List

Select Remove Call from
Hot List from the Group
menu.
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1





5

FINDING INFORMATION   5-1

Finding
Information

IN THIS CHAPTER

Finding Call Records for a
Customer or Employee

Browsing Call Records

Finding Call Records by
Call ID Number

Finding Transferred Calls

Activity Logs

Finding Table Entries

Quick Searching Validated
Fields

Finding Records with
Simple Search

Finding Records with
Boolean Search

Finding Profile, Contact,
Configuration, and Call
History Records

HEAT search engines help you find records that
meet one or more criteria. With a Simple
Search, you can quickly select predefined search

criteria set up in your system by the system administrator.
Simple Searches use only one search condition. You can
also create a Boolean Search. Boolean Searches use search
criteria defined by you, and can use multiple conditions
and operators.
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Finding All
Call Records
for a Customer
A  Call History is a record of
all calls for a single customer.
You can quickly view the
customer�s  calls by opening
the Call History window.

Find All Call Records
for the Current
Customer or
Employee

Select Call History from the
Customer menu.

Double-click a Call Record
to view it.

2

1

2

1

TIP
You can access a caller�s history by
using the Caller History button on
the toolbar.
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Browsing Call
Records
You can browse through a list
of Call Records to locate a
specific Call Record in a
group.

Browse Call
Records

Select Call Record Browse
from the Group menu.

Browse through the list of
Call Records.

Select Synchronize
Displays if you want the Call
Logging Screen to display
the Call Record that is
highlighted on the browser
window.

To go to the highlighted Call
Record, click Go To Call.

Call Record Synchronized with Browse Record
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Finding  Call
Records by
Call ID
Number
You can retrieve any Call
Record by its Call ID Number.

Find a Call Record

Select Go to Call ID from
the File menu.

Type a Call ID number.
Leading zeroes are not
required.

Click OK. The Call Record
appears in the Workgroup. 1
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Finding
Transferred
Call Records
When another support center
transfers a Call Record into
your HEAT system, the Call
Record gets a new Call ID.
This puts it in sequence with
your other Call Records.
If the transferred Call Record
has an existing Call ID, that ID
is recorded in the Call Transfer
Log. Use this procedure to find
the Call Record by its original
Call ID.

Find a Transferred
Call Record

Select Call Transfer>>
Find Transferred Call from
the Accessory menu.

Type the original Call ID in
the Call ID field.

Click OK. 2
3
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Viewing the
Activity Log
An Activity Log contains
activity information about a
specific Call Record. Your
system administrator
determines whether the
Activity Log is on or off.
You can use the Activity Log to
provide information. For
example, you can create a new
Activity Log entry when the
Stopwatch starts. It can
display the name of the
Tracker who opened the Call
Record, the status of the Call
Record during that time, and
the amount of time that a
person worked on it.
You can generate an activity
log automatically, as well as
type, modify, or delete Activity
Log entries. The Total Duration
field displays the combined
time spent on all of the Call
Record�s activities.

View an Activity Log

Select Activity Log from the
View menu.

Click Exit to leave the
window.

2

1

2

1

TIP
You can access a Call Record�s
Activity Log by using the Activity
Log button located at the bottom of
the Call Record Screen.
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Adding
Records to the
Activity Log
An Activity Log contains
information about activity
pertaining to a Call Record.

Add a Record

Select Activity Log from the
View menu.

Click Add Record.

Type the appropriate
information in the applicable
fields.

Click OK. Your entry
appears in the Activity Log.

TIP
You can add, edit and delete
records from the Activity Log only
if you have security rights to
perform those tasks.
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Editing
Records in the
Activity Log
An Activity Log can be
manually edited to add,
change or delete information.

Edit a Record

Select Activity Log from the
View menu.

Highlight an entry in the
Activity Log and click Edit
Record.

Edit the record by typing
new information in the
appropriate fields.

Click OK. The changed entry
appears in the Activity Log
grid.

TIP
You can add, edit and delete records
from the Activity Log only if you
have security rights to perform
those tasks.

TIP
The Start Date and Start Time in
the Activity Log cannot be edited. 3
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Deleting
Records from
the Activity
Log
Information in an Activity Log
can be deleted. You cannot,
however, delete the entire
Activity Log.

Delete a Record

Select Activity Log from the
View menu.

Highlight an Activity Log
entry.

Click Delete Record.

Click Yes.

Click Exit.

TIP
You can add, edit, and delete
records from the Activity Log
only if you have security rights
to perform those tasks.
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Finding Table
Entries
Use Table Maintenance to
browse through a grid view of
selected data. This is a fast
way to find a record for
editing.
Your system administrator
controls rights to modify
tables.

Find a Table Entry

Select Table Maintenance
from the Accessory menu.

Select a table from the
Table drop-down box.

Click a column heading to
sort the column in
alphanumeric order.

Browse through the table to
find the entry you want.

Double-click the table entry.
The selected form appears.

TRY THIS
In any validation table click a
column heading to sort the column
in ascending order. Hold down
Shift and click a column heading to
sort the column in descending
order.
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Complete the formula in the
Expression Text area by
using the Table Name and
Field Text lists a second
time.

Select @functions from the
Table Name drop-down list.

Double-click @validated
prompt in Field.

Go to next page.

Adding a
Validated
Prompt
Some HEAT fields only accept
entries that appear in a linked
Validation table. You can use
the Add Validated Prompt
feature to access drop-down
lists of validated information.
You can use this feature when
you set up new Call Groups or
AutoTasks.

Add a Validated
Prompt in a Call
Group

Select New Call Group from
the Group menu.

Type the name of the Call
Group and the description.

Select the name of the
table.

Double-click the name of the
field.

Double-click the operator.
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Type the name of the field
followed by a colon.

Select the correct table and
field name.

Select OK.

Click the Check button.

Select the validated
information from the drop
down list or click the
Validate button for a more
complete list.

Select OK.
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14

Add Validated Prompt
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Quick Search a
Validated Field

Right-click any field in a
validation table. The field you
click becomes the first
column in the Validation
window. This example uses
the Company field.

Select Validate Field.

Type one or more characters
of the word you want to find.
The characters appear in the
Quick Search field.

Click Search.

Select the record you want.

To edit the record, click Edit.

To populate the currently
displayed Call record with
this information, Click OK.

Quick
Searching
Validated
Fields
A Quick Search finds validated
records that begin with the
same letter or number, or have
the same letter-number
combination. A Quick Search
only searches the first column
in the Validation window.
The percent character % is a
wildcard. A search for ja% will
find Janice, Jake, and Jalille. A
search for %ka% will find
Karen, Ekatarina, and Malka.
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Select Another Field
to Search

Hold down CTRL and click
the heading of the field you
want to search. The Quick
Search dialog box appears.
The examples on the next
two pages show how to
Quick Search other fields.

TRY THIS
In any Validation window, click a
column heading to sort the column
in ascending order. Hold down
Shift and click a column heading to
sort the column in descending
order.

TRY THIS
To narrow a search to a state, select
the �State� field and search for the
state. To narrow a search to a city,
select the �City� field and search for
the city.
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TIP
The percent character % is a
wildcard. A search for la% will
find Landon, Lars, and
Laurianne.

Quick Search for
Words Beginning
with the Same
Characters

Type the first letter or
letters of the word you
want to find. Be sure the %
is the last character. This
example searches the City
field for cities beginning with
the letters colo.

Click Search.

Double-click a Record to
view it.

Click OK to populate the
currently displayed Call
Record with validated data.
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TIP
The percent character (%) is a
wildcard. A search for %ig% will
find Ignacio, Luigi, and Solveig.

Quick Search for a
Combination of
Characters
Anywhere in a Word

Type the characters in the
word you want to find. Type a
% before and after the
letters. This example
searches the Contact field
for contacts with the letters
MI anywhere in their names.

Click Search.

Double-click a Record to
view it.

Click OK to populate the
currently displayed Call
Record with validated data.
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TIP
To perform a Simple Search on a
field, right click on the field and
select Simple Search.

Finding
Records with a
Simple Search
A Simple Search searches for
all Call Records with a
common feature, such as a
Company or a Tracker. Your
system administrator creates
the list of Simple Searches,
from which you can make
your selection.
The Simple Search dialog box
works the same way for all
search fields.

Search for All Call
Records with a
Common Feature

Select Simple Search from
the Group menu.

Select a field to search.

Select a logical operator.

Click Browse.

Select the data you want to
locate.

Click Select.

To restrict the search to a
single Call Group, click
Narrow an open call
group and then select a
Call Group from the drop-
down list. The search is
confined to members of that
Call Group.

To create a new Call Group
to contain the Call Records,
click Create a new call
group. A new Call Group will
be created that contains the
Call Records found by this
search.

Click Run.
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TIP
An operator defines the logical
relationship between a selected
data field and its contents.

TIP
To expand a Simple Search to a
Boolean search, click the browse
button in the Simple Search
dialog box and the Boolean
button in the Validate from
Profile dialog box.



Boolean Searches
What is a Boolean Search?
Searches are designed to locate information based on certain
conditions (also called expressions). Simple Searches include only
one expression. For example, you can run a Simple Search to find
all the Open Call Records.
If you want to use other expressions to refine your searching
criteria, you must use a Boolean Search. For example, let�s assume
that Chris Tracker wants to find all Open Call Records assigned to
him. The search Chris defines has two conditions:

CallLog.CallStatus = �Open� AND CallLog.Tracker = �Chris�

This instructs HEAT to find all Call Records with a call status of
�Open� and that have Chris listed as the tracker.

How the AND and OR Connectors Work
When defining a Boolean Search, you can use the AND and OR
connectors, which join the conditions in your search criteria and
instruct HEAT to find Call Records that contain ALL values or
ANY of the values.

Using the AND Operator  
When you connect two conditions with AND, HEAT looks for Call
Records that contain both values you have specified. For example,
you want to find all open Call Records that have �hardware� as
the call type and �DClark� as the tracker. Your expression would
look like this:

CallLog.CallStatus = �Open� AND CallLog.CallType =
�Hardware� AND CallLog.Tracker = �DClark�

Using the OR Operator    
When you connect two conditions with OR, HEAT returns Call
Records that contain any of the selected values. For example, you
want to find any calls made about either Lotus 1-2-3 issues or MS
Excel issues. CallLog.CallType=�Excel� OR

CallLog.CalType=�Lotus 123�

EXAMPLES

Using the >= Operator

Let�s assume you want to find all the calls received this month. To
do this, you want to locate all the calls that are greater or equal to
a specific date. Your expression would look like this:

CallLog.RecvdDate >= �1998-11-01�

Note that the date must be manually entered into the Expression
field and must follow the YYYY-MM-DD  format.

Using the <> Operator

One of the more common types of Boolean Searches is to find all
the Call Records that are not closed. The search results would
include records that are open, pending, reopened, etc. Your
expression would look like this:

CallLog.CallStatus <> �Closed�

Using the like Operator
You can use the like operator to find text within a Call Record.
Let�s assume that you closed a Call Record several weeks ago but
need to review it again. You can�t remember the customer�s name
but can recall that the call description had the word �training� in it.
You can use the like operator to find the Call Records that include
�training� in the Call Description. Your expression would look like
this:

{CallLog.CallDesc} like �%training%�

Note that the % is used as a wildcard. The % instructs HEAT to
find all Call Records that have the word �training� anywhere in
the Call Description.

Using the is empty Operator

Use the is empty operator to find empty fields. For example, you
might want to find all Call Records with an empty Priority field.
The expression you create would look like this:

CallLog.Priority is empty
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Find a Customer
Profile Record from
Call Logging

Select Search from the
Customer menu.

Select the Customer Type.

Select the field to search.

Select a logical operator.

Click Browse.

Select the value to search
for.

Click Select.

Select the sort order
criterion.

To modify the scope of this
search, click More and go to
the next page.

To search on these criteria,
click Search.

Finding
Records with a
Boolean
Search
Use a Boolean Search to find
customer records: Profile,
Contact, Configuration, or
Call History.
You can narrow the scope of a
search with the logical
operators AND and OR. If you
put AND between two
conditions, HEAT searches for
records with both conditions.
If you put OR between two
conditions, HEAT searches for
records with either condition
or both.
The default sort order is
Customer ID. This example
shows a Boolean Search used
to find a customer profile
record.
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Modify the Scope of
Your Search

Click Add. The search
criteria appear in the
Condition List.

To search for both of two
conditions, click And. To
search for either of two
conditions, or both, click Or.

Select the customer type.

Select the field to search.

Select a logical operator.

Click Browse.

Select the value to search
for.

Click Select.

Select the sort order
criterion.

Repeat steps1-9 as
necessary.

Click Search.

TIP
You can modify the scope of your
search with the logical operators
AND and OR.
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Find a Customer
Profile Record from
the Customer
Window

Select Profile from the
Customer menu.

Select Find from the
Record Menu. The Find
dialog box will appear.

Select the customer type.

Select the field to search.

Select  a logical operator.

Click Browse.

Select the value to search
for.

Click Select.

Select the sort order
criterion.

To modify the scope of this
search, click More.

To search on these criteria,
click Search.
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Finding Profile,
Contact,
Configuration,
and Call
History
Records
Use a Boolean Search to find
customer records: Profile,
Contact, Configuration, and
Call History.
You can narrow the scope of a
search with the logical
operators AND and OR. If you
put AND between two
conditions, HEAT searches for
records with both conditions. If
you put OR between two
conditions, HEAT searches for
records with either condition or
both.
The default sort order is
Customer ID. This example
shows a Boolean Search used to
find a customer profile record.
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First Level
Support

IN THIS CHAPTER

Accessing FLS

The FLS Window

Knowledge Trees

Distribution Files

Tree Properties

Passwords

User Status

Nodes

Noise Words

Searching the Tree

Confidence Values

Search Results

Text in Nodes

Adding Nodes

Posting Results

Copying Text

Printing

Creating Trees

Customizing Links

First Level Support (FLS) is a simple and powerful tool
used for building knowledge bases. These knowledge
bases, whether purchased or custom-built, provide

answers to questions, solve problems, and share
knowledge.
In First Level Support, knowledge is arranged in a tree
format, like an outline. You can break each item of
information, or node, of a knowledge tree into subtopics.
These subtopics, called child nodes, can have children of
their own, and so on. These parent-child relationships form
the branches of a knowledge tree. You can quickly find
answers in First Level Support by browsing through a
knowledge tree�s nodes with the keyboard or mouse or by
searching for key words or phrases.
First Level Support lets you install, build, and use as many
knowledge trees as your system resources allow. When you
need to preserve important knowledge, you can quickly
build your own knowledge trees or add to existing ones.
You can attach external files such as word processing
documents, spreadsheets, even video clips, to provide
knowledge trees that are rich with information.
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Accessing First
Level Support
First Level Support is
launched from Call Logging.

TIP

Access First Level
Support from the
Menu

Select First Level Support
from the Solution menu.

Access First Level
Support from the
Toolbar

Click the First Level
Support  icon.

If the First Level Support Program
Location dialog box appears in front
of this window, the path from Call
Logging to the First Level Support
module has not been set up.

1

1

1

1



The First Level Support
Window
First Level Support has a tree and branch structure. The main
topic, First Level Support, is the tree. Each topic is called a
�branch� or �node.� Topics can branch out into more
detailed information subtopics.
The First Level Support screen has four windows.

� The Tree Display window is on the left side of the
screen. Use it to navigate through your tree and
display the nodes and branches.

� The Problem description is on the upper right-hand
screen. It displays a detailed description of the
problem.

� The Solution description is on the lower right-hand
screen. It describes the solution to the displayed
problem.

� An Abstract appears above the tree window. It
describes the currently selected node.

Abstract

Tree Display

Problem
Description

Solution
Description

Attachment
Icon

Security
Status
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Open a Tree

Select Open from the File
menu in First Level Support.

Choose the appropriate
knowledge tree.

Click Select.

Opening
Knowledge
Trees
You can open a tree from the
File menu in FLS.
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Closing
Knowledge
Trees
You can have several
knowledge trees open at the
same time. Closing a tree has
no effect on other open trees.

Close a Knowledge
Tree

Select Close from the File
menu.

Close All
Knowledge Trees

Select Close All from the
Window menu.

1

1

1
1



6-6  AT A GLANCE

Importing and Exporting
Knowledge Trees
You can import knowledge trees created by colleagues in
your organization. You can also purchase knowledge trees
from GoldMine or third-party developers, giving you instant
access to specialized knowledge.
If you've created a tree, it's also easy to export. You can then
distribute the tree to your coworkers.
There are two ways to export knowledge trees:

� Distribution files (*.DST) contain a copy of the
knowledge tree, plus all attached files (if you choose), in
a compressed format. Use Distribution files to recreate a
complete knowledge tree at a different location.
A Distribution file assumes that the new knowledge tree
will not have access to the original attachment files. If
you choose to include attachments, a Distribution file
includes copies of the actual files.

� Generic files (*.DAT) are specially formatted ASCII text
files that contain all of the tree's information, plus
instructions for recreating its structure.
A Generic file is a bridge between First Level Support
and other applications. A Generic file is an
uncompressed ASCII text file. You can edit one in any
word processor, or create one with a good database
application.
Unlike a Distribution file, a Generic file assumes that it
has not left home. If you choose to include attachment
information, a Generic file records the DOS path and file
name of attached files but does not contain copies of the
files themselves. If you use a Generic file to recreate a
knowledge tree at a different site, you must also send
copies of all attached files.
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Importing a Generic file
When you import a Generic file, First Level Support interprets
the file to create a knowledge tree in the destination
subdirectory.
A Generic file assumes that it won't leave its original location,
so attachment files are not copied. Instead, the path and file
name of each attachment is stored in the .DAT file.
Since a Generic file is an ASCII file that you can create or edit
in a text processor or database, First Level Support inspects
each Generic file before importing it. The results of this
inspection appear in the Import Statistics dialog box.

Importing a Distribution file
When you import a Distribution file, First Level Support
decompresses the file to create a knowledge tree in the
database. If the distribution file includes attachments, you
will be asked to choose a directory for those attachments.
Since a tree's original attachment files may have been drawn
from many locations on a network, attachment files are
renamed to prevent conflicts. The new file names include
"FLS" plus a sequence number, and retain their original
extensions. For example:

FLS0001.PCX
FLS0002.TXT
FLS0003.AVI

You can replace an existing knowledge tree by importing a
Distribution file over it. You will typically do this when
installing updated copies of commercial knowledge trees. If
the Distribution file includes copies of attachment files, you
will need to decide what to do with the original attachment
files. For example, let's assume you once used a Distribution
file to import a knowledge tree with attachments  into the
directory C:\TREES\ASPEN .
When you begin to import the updated version of ASPEN,
First Level Support sees that C:\TREES\ASPEN already
contains attachment files. At that point, it displays the Tree
Import dialog box, asking you to decide what to do with the
files.
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Importing
Knowledge
Trees
At times, you may want to use
knowledge trees created by
other parties. You can easily
import distribution files
(*.DST) or generic files (*.DAT)
into First Level Support.

Import a Tree

Select Import from the File
menu.

Click Select Source.

Select the file you want to
import. You may need to
navigate to the file.

Click Open.

Click Select Target Tree.
The Tree Selection dialog
appears.

Choose the tree into which
you want to import the
information or click New
Tree to import the
information in a new
knowledge tree.

Click Select.

Click Attachment
Directory.

Navigate to the folder where
attachments for this tree are
to be stored.

Click OK.
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Exporting
Knowledge
Trees
You can export the currently
selected branch or an entire
tree from First Level Support.
Files exported must be a
distribution file (*.DST) or a
generic file (*.DAT).

Export a Tree

Select a node or tree from
First Level Support.

Select Export from the File
menu.

Select the export type. You
can export a tree or the
currently selected branch.

Click OK.

Type a  filename in the File
name field, then  navigate to
the location where you want
the tree saved.

Check Remove Links if you
want to remove any
attachment references. Clear
the box if you want to retain
attachment references.

Click Save.

TIP
You must have edit or
administrator privileges before you
can export a tree.

Options>>Editing Allowed or
Administrator Options must be
enabled.
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Setting
Knowledge
Tree
Properties
By setting properties, you can
include identifying
information in a knowledge
tree, define text area captions,
store a user limit to control
access, or add password
protection. You may set or
change the properties of any
knowledge tree that you can
edit.

Define the First
Level Support Path

Select Properties from the
File menu.

Type the maximum number
of users with simultaneous
access to this tree. A zero
grants unlimited access.

Type names for the upper
text area and lower text area
in the Text area descriptions
box.

Type a description for the
current knowledge tree or
record copyright information
in the Tree Information
box.

Click Password to set up a
password for the
Administrator (see next
page).

Note: The Administrator
password must be set before
the Editor or Tree Deletion
password can be set.

Click OK.

2
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1

SEE ALSO
See also Setting Passwords, in this
chapter.
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TIP
If the Administrator Options item
is disabled in the Options menu,
the Properties are read-only.
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Setting
Passwords
You can set three passwords to
prevent unauthorized editing
of a knowledge tree.
Setting the Editor password
prevents a user from adding,
editing or marking nodes for
deletion. Setting the Tree
Deletion password prevents
users from deleting entire FLS
trees.
These options are not available
unless the Administrator
password is set.
You must have the
Administrator Options
enabled to set a password.

Set a Password

Select Properties from the
File menu.

Click Password for either
the Editor,  Administrator
or Tree Deletion.

Note: The Administrator
password must be set before
the Editor or Tree Deletion
password can be set.

Type the current password.

Type the new password.

Type the new password
again to verify it.

Click OK.

Click OK.

TIP
Passwords are case-sensitive.

TIP
Record your password in a safe
place. If you forget your password,
it cannot be recovered and you will
not be able to edit your knowledge
tree.
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Removing
Passwords
If you have already set a
password and decide to allow
access to all users, you can
remove the password.

Remove a Password

Select Properties from the
File menu.

Click Password for either the
Editor, Administrator or
Tree Deletion.

Type the current password.

Leave the New Password
field blank.

Leave the Confirm New
Password field blank.

Click OK.

Click OK.
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Changing
User Status
In each knowledge tree, you
can have one of three levels of
editing rights. You can check
your user status through the
menu as described on the
right, or by the icon
represented in the First Level
Support status bar.
To change your user status,
you must have the
appropriate security rights.
The icons represent the
following:

  Administrator: Has
full rights

  Editing Allowed: Can
add and edit nodes, subject to
the Administrator�s approval.
Can also mark nodes or
branches for deletion subject
to the Administrator�s
approval.

  Viewing Only:  Has
no editing or administrator
rights.

Change User Status

To allow edit rights, select
Editing Allowed from the
Options menu.

Type your password then
click OK. A check mark
indicates you have edit
rights.

Note: In order to use this
option, a password must
have already been set in the
Tree Properties menu.

To get Administrator Rights,
click Administrator
Options, then type your
password and click OK.
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Adding Nodes
When you need to add more
information to an existing tree,
you can add a node to a
knowledge tree. When you add
a node, you are creating a
child of the current node. The
branch automatically expands
to display the newly created
node.

TIP
Before you can add nodes, you must
have edit or Administrator rights.
Options>>Editing Allowed
must be enabled in First Level
Support.

Add a Node

Highlight the node that will
be the parent of the node
you want to create.

Select Add Child from the
Node menu. A new Dialog
box appears.

Enter a title for the node�s
label.

Enter an abstract for the
node.

Enter text for the
Description window.

Enter text for the Solution
window.

Click Save.

SEE ALSO
Adding Nodes Through the Search
Results Dialog, in this chapter. 7
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Editing Nodes
You can edit information in an
existing knowledge tree at any
time.
Your ability to edit First Level
Support is based on your
security rights.

Edit a Node

Highlight the node that will
be edited.

Select Edit from the Node
menu.

Edit the node.

Click Save.TIP
Before you can edit nodes, you must
have edit or Administrator rights.
Options>>Editing Allowed  or
Options>>Administrator
Options must be enabled in First
Level Support.
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Adding and
Viewing
Attached Files
First Level Support provides a
great deal of flexibility to
document problem
resolutions. You can attach
files and documents to a node
to further explain problem
resolutions.
The Attachment bar displays
files and applications
attached to the current node.
Attachments can be word
processing documents,
spreadsheets, graphics files,
even video clips.

Add an Attachment

Highlight a node.

Click the Attachment icon in
the Attachment bar.

Select Add Attachment.

Enter a description for the
attachment.

Enter the attachment
location or click Browse to
navigate to it.

Click OK.

View an Attachment

Highlight a node.

Click an attachment in the
Attachment bar.
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Changing the
Sort Order of
Trees
You can sort a tree�s nodes
alphabetically or by the
number of times a solution has
been used. You can then sort
by Ascending (lowest to
highest) or Descending order
(highest to lowest).

TIP
Times Solution Used numbers are
incremented when you post a
solution back into a Call Record. If
your help desk does not post
solutions, zero appears for all nodes.
You can also change this with
Node>>Change Times Solution
Used>>Increment.

Change the Sort
Order of a Tree

Select Sort By from the
Options menu.

Select Alphabetical to sort
the tree alphabetically or
select Times Solution
Used to sort the tree by the
number of times a solution
has been used.

Select Sort By from the
Options menu.

Select Ascending or
Descending.
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Noise Words
First Level Support ignores noise words while searching. FLS
reads noise words if they appear within quote marks. The
following is a list of noise words. You cannot add to or edit
the noise word list.

a about after al l along

also an another any are

aren�t a s at be because

been before being between both

but by came can can�t

come could couldn�t could�ve did

didn�t do don�t each for

from get got had hadn�t

has have haven�t he her

here herself h im himself his

how I if in into

i s isn�t it i ts just

like made many me might

mightn�t more most must my

never not now of on

only other our out over

said same see she should

shouldn�t should�ve since some stil l

such take than that the

their them then this those

through thus to too under

up usually very was way

we well were what when

where which while who with

would wouldn�t would�ve you your
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Searching
Knowledge
Trees
To perform a search, you must
tell First Level Support to find
certain words within nodes.
First Level Support finds the
nodes that contain some or all
of those words. You can search
within the current knowledge
tree, or search several trees at
once.
A search query can contain
any number of words or
phrases, up to a limit of 100
characters. You may use
logical operators and quote
marks to build simple and
complex queries. To find nodes
or paths that contain all the
words in the query, connect
words with AND. First Level
Support assumes words are
connected with OR unless you
say otherwise. Place double
quotes around strings of text to
search for exact matches.

Search the Current
Knowledge Tree

Select Search Tree from
the Search menu.

Enter the search query in
the Query box. To view
previous queries, click the
down arrow.

Select the area to search.

Click Current Branch or
Entire Tree to set the range
of the search.

Check Match case to
perform a case-sensitive
search.

Check Whole Words Only
to search only for words that
match.

Click OK.

SEE ALSO
Adding Nodes Through the Search
Results Dialog, in this chapter.
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Searching
Multiple
Trees
If you have more than one
knowledge tree, you can
search all your trees
simultaneously.

Search Multiple
Trees

Select Search Multiple
Trees from the Search
menu.

Type the search query in the
Query box.

Select the area to search.

Check Match case to
perform a case-sensitive
search.

Check Whole Words Only
to search only for words that
match.

Select either Search All
Open Trees or Search
Listed Trees.

If you select Search Listed
Trees, click Add Tree to
add a tree to the list.

Highlight a tree.

Click Select.

Click OK to begin a search.

To remove a tree from the
list, highlight it and click
Delete Tree.

Click OK.

TIP
If you selected �Search Listed
Trees,� you can add one or more
trees.
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Using
Confidence
Values
Nodes can be sorted based on
the percentage of search words
found in each node. This
percentage is called the
Confidence Value.
For example, if you search for
the words Lotus AND files, all
nodes containing both Lotus
and files receive a score of
100%. All nodes containing
either Lotus or files receive a
score of 50%. If you search for
3 words, you might see scores
of 100%, 66% and 33%.

Set up Confidence
Values

Select Calculate
Confidence Value from the
Search menu. A check mark
appears next to the menu
item.

1
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Using Search
Results
The Search Results dialog box
displays the name and
knowledge tree of each node
that meets your search
conditions. To see each node�s
complete path, select the Full
Path Names option in the
Display box.
The lower left of the Search
Results window displays your
query as well as the starting
node of the search.

View Search Results

After you have completed
your search, select a node
name from the Search
Results window.

Select a Display type to see
only the node names or the
full path name.

Click Select. The node you
select is highlighted in the
Tree display.

1

2

3

TIP
You can sort the search results by
clicking on the column headers.

3

2

1



FIRST LEVEL SUPPORT   6-23

Finding Text
in Nodes
You can use the Find option to
locate text in a node�s upper
text area or lower text area.

TIP
Highlight the first occurrence of the
word or phrase before you select
�Find�... or press F3. When the
Find dialog box appears, the
highlighted text is already in the
�Find What� box.

Find Text in a Node

Highlight the node.

Click in either the upper or
lower text area.

Select Find from the Edit
menu.

In the Find What field, type
the word or phrase you want
to find.

Check Match Case to
perform a case sensitive
search.

Select the direction of the
search, starting from the
current cursor position. Up
searches up to the root of
the tree. Down searches
down to the last node of the
tree.

Click Find Next. The first
occurrence of the text is
highlighted in the text area.
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Adding Nodes
through the
Search Results
Dialog Box
After running a search, you
can quickly add new nodes by
clicking the Auto Populate
button.

Add a Node

In the Search Results
dialog box, select a tree and
node.

Click Auto Populate.

. Enter a name for the tree if
you want to add a node to a
different tree. The current
knowledge tree appears by
default.

Enter a label name.

. Enter an abstract for the
new node.

Enter text for the upper text
area. Your query words
appear by default, but you
can overwrite them. (Noise
words will not appear in the
default text.)

Enter text for the lower text
area.

Click OK.

TIP
You must have edit or
administrator privileges before you
can add nodes.
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Posting
Solutions to
HEAT
If your help desk stores
problem solutions in the lower
text area, you can transfer this
information to a designated
memo field in the current Call
Record.
Before you can use this feature,
the current Call Record in the
Call Logging Module must be
editable.

If an empty Work Group is in the
foreground or if the current Call
Record is closed or locked, First
Level Support cannot transfer a
solution.

Post Solution to a
Call Record

Make sure that the Call
Record is displayed in Call
Logging.

In First Level Support,
highlight the node that
contains the solution.

Select the Post Search
Solution from the Search
menu. The text in the lower
text area of the current node
is sent to the memo field
defined in the Administrator
Module. The node�s �number
of times solution used�
counter is incremented by 1.

TIP
3

1
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3
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Copy Part of a Node
or Branch

Highlight the text you want
to copy.

Select Copy Special from
the Edit menu. The Copy
Special dialog box appears.

Click Current Node or
Current Branch.

Select the parts of the node
or branch you want to copy.

Click OK. Information is
copied to the clipboard.

Copying Text
You can copy selected text in a
knowledge tree or parts of a
node or branch. The
information can then be pasted
into another application, such
as a Call Logging journal or
solution description.

Copy Text

Highlight the text you want
to copy.

Select Copy from the Edit
menu. Information is copied
to the clipboard.

1

2

1

2

3

4

5

5

4

3

2

1

2

1



FIRST LEVEL SUPPORT   6-27

Copying Text
Into First Level
Support
You can copy plain text (ASCII
format) from other Microsoft
Windows applications into
First Level Support by using
the Copy and Paste functions.
First Level Support does not
support word processor
formatting such as boldface
text or special fonts. Tabs are
preserved, but you cannot set
tabs from First Level Support.

Copy Text into First
Level Support

Copy text from the other
application.

Select Edit from the Node
menu.

Place the cursor where you
want to paste the text.

Select Paste from the Edit
menu.
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Printing
Information
First Level Support offers fast
and simple printing to help
you capture information from
a knowledge tree. You can
print a single node or an entire
tree.
Page numbers are
automatically placed at the
bottom of each page.
Certain text printing options
are preset. These options
cannot be changed within
First Level Support:

� Font:  Times Roman (or
closest equivalent on
your printer)

� Size:  10 point
� Margins:  0.5 inches on

all sides
� TAB stops:  0.5 inches

TIP
If you need more control over the
look of your printed output, print to
a File destination. Then use a word
processor to format the output file
to your specifications.

Print a Single Node

Highlight the node to print.

Select Print from the File
menu.

Select Current Node.

Select the parts of the
node you want to print.

Click OK.

Print a Branch
Highlight the branch to print.

Select Print from the File
menu.

Select Current Branch.

Select Tree Structure to
print a graphic representation
of the tree. Select Nodes to
print the text stored in each
node.

Select the parts of the
node you want to print.

Click OK.6
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TIP
First Level Support can print 32
levels of nodes in a single branch.
Nodes at the 33rd level or beyond,
relative to the branch�s parent
node, do not appear in a printout.

Print a Knowledge
Tree

Highlight the tree to print.

Select Print from the File
menu.

Select Current Branch.

Select one output option:

� Tree Structure: Prints a
graphic representation of
the node labels and
branch icons.

� Nodes: Prints the text
stored in each node, in
the order the nodes would
appear in the Tree display
or a Structure printout.
You must also select a
separator type from the
drop-down box.

Select the parts of the
node you want to print.

Click OK.6

5

4

3

2

1

5

4

6

3



6-30   CALL LOGGING AT A GLANCE

Creating
Knowledge
Trees
All First Level Support users
can create new knowledge
trees, even if they do not have
security rights to edit an
existing tree.

TIP
You can type three lines of text that
describe the current knowledge tree
or record copyright information.
You may type 70 characters per
line.

Create a Tree

Select New from the File
menu.

Enter  the filename for the
new tree.

Enter the maximum number
of users with simultaneous
access to this tree. A zero
grants unlimited access.

Enter names for the upper
text area and lower text area
in the Text area descriptions
box.

Enter a description for the
current knowledge tree or
record copyright information
in the Tree Information
box.

Click Password to set up a
password for  Administrator.

Click OK.
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Customizing
First Level
Support
You can customize First Level
Support to meet your needs.
For example, you can adjust
the sizes of the Tree display,
the upper text area, and the
lower text area. You can also
hide or display the
Attachment Bar, Toolbar,
Status Bar, text area captions,
and Times Solution Used.

Customize First
Level Support

Select Attachment Bar from
the View menu to hide or
display the Attachment Bar.

Select Captions from the
View menu to hide or
display the captions on
upper and lower text areas.

Select Status Bar from the
View menu to hide or
display the Status Bar.

Select Toolbar from the
View menu to hide or
display the Toolbar.

Select Display Times
Solution Used from the
Node menu to hide or
display the Times Solution
Used.
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Adding Links
to Other
Programs
You can build a list of
shortcuts to your favorite
programs and tools. Any
application file (.EXE or .COM)
or Program Information File
(.PIF) can be added to the Tools
menu, then launched directly
from First Level Support.

Add a Link

Select Configure from the
Tools menu. The Tools
dialog box appears. The
Menu Contents displays
the current list of programs
in the Tools menu.

Click Add.

In the Open  dialog box,
navigate to the application
or PIF you want to add to
the Tools menu.

Click Open.

Enter the title you want to
appear in the Tools menu.

If your application needs to
be run from a particular
directory, enter the
directory in the Working
field.

Check Ask for arguments
to allow arguments, such as
a file name, to be passed to
the program before it
launches this application.

Click OK.
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Rearrange Link List

Select Configure from the
Tools menu.

Highlight an application
name in the Menu
Contents dialog box.

Click Move Up to move the
item up in the list.

Click Move Down to move
the item down in the list.

Click OK.

Delete a Link

Select Configure from the
Tools menu.

Highlight an application
name in the Menu Contents
dialog box.

Click Delete to remove the
link.

Click Yes.

Click OK.

TIP
When you rearrange or delete a tool
in First Level Support, only the link
to the tool is removed. The
application or file does not get
removed from your system.
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Reports
IN THIS CHAPTER

HEAT Answer Wizard
Reports

Crystal Reports

Running Crystal Reports

Displaying Crystal Reports

Printing Crystal Reports

Saving Reports

E-Mailing Reports

Call Logging Reports

Previewing Call Tickets

Printing Call Tickets

Printing Call Tickets for a
Call Group

Viewing Reports

Printing Reports

Printing by Call Type

HEAT can produce reports about your support
center and customers. You can view a report on-
screen or print it. HEAT gives you several ways to

produce reports:

� HEAT Answer Wizard � You can run over 250
predefined reports, or create your own.

� Crystal Reports � You can create reports with the
industry�s leading report writer, and produce them from
Call Logging.

� Call Logging � You can print, view, or e-mail
information from a Call Record. A printed Call Record
can include information from the Profile Subset, the Call
Log, Details, Assignment, and Journal.
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HEAT Answer Wizard
Reports
HEAT Answer Wizard reports answer key business questions.
You can use one of  the standard reports, or create new ones.
HEAT Answer Wizard has six categories of reports:
� Favorite Reports: contains copies of any reports you have

saved to this directory.
� HEAT: contains predefined reports specifically related to

HEAT.
� Combined Reports: contains predefined reports that use

information from HEAT and the Manager�s Console.

You must have the appropriate security rights to access
information from each module.
For more information refer to the HEAT Answer Wizard
User�s Guide in the System Administrator manual.
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Crystal Reports
Crystal Reports is a report generator application that comes
with HEAT. With it, you can design, create, and print reports.
You can select a report format, or design your own. Each
report can extract information from a data file or database,
and display the information in the selected format. After you
design a report, you can run it from Call Logging.
For more information, refer to the Crystal Reports User�s
Guide.
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Running
Crystal
Reports
You can start Crystal Reports
from Call Logging. Before
running Crystal Reports, you
must set the path to the
application through User
Preferences.

Run Crystal Reports

Select Report Writer from
the Accessory menu.

SEE ALSO
Setting Paths in �User
Preferences,� Chapter 10.
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Displaying
Crystal
Reports
After you create and save a
report with Crystal Reports,
you can display it from Call
Logging.

Display a Report

Select Run Reports from
the Accessory menu.

Select the report to display.

Select Window in the
Output To drop-down box.

Click Run.4
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Printing
Crystal
Reports
You can print a report created
in Crystal Reports from within
Call Logging.

Print a Report

Select Run Reports from
the Accessory menu.

Select the report to print.

Select Printer in the Output
To drop-down box.

Click Options.

Select printer options.

Click OK.

Click Run.
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Saving Reports
You can save a report to a file
on disk.

Save a Report

Select Run Reports from
the Accessory menu.

Select the report to save.

Select Disk File in the
Output To drop-down box.

Click Browse to locate the
output file name or type the
name in the Output File
Name box

Select an export file
format.

Click Run.
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E-Mailing
Reports
From Call Logging, you can e-
mail a report created in Crystal
Reports.

E-Mail a Report

Select Run Reports from the
Accessory menu.

Select the report to e-mail.

Select Send via Mail in the
Output To drop-down box.

Click browse to locate the
output file name.

Select an export file
format.

Click Delete File After
Mailing if you want the file
deleted after it is sent.

Click Run.
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Call Logging Reports
A Call Record, also called a Call Ticket, is an electronic record
of a support center Call. The example shown includes
information about the customer, Call Log, Call Details,
Assignments, and Journals.
You can print information from a Call Record as shown on
the right. You can also view a Call Record on-screen, save its
data in a file, or send it by e-mail.

Call Record

Printout of Call Record



7-10   CALL LOGGING AT A GLANCE

Previewing
Call Tickets
Use Print Preview to view a
Call Ticket on-screen before
you print it.

Preview a Call Ticket

Select Print>>Preview from
the File menu.

Use the Preview window
buttons to view the Call
Ticket.

� Next page � Displays the
next page.

� Prev page � Displays the
previous page.

� Two page � Displays two
pages at a time.

� Zoom in � Magnifies the
preview image.

� Zoom out � Reduces the
preview image.

Click Print to print the Call
Ticket.

Click Close to close the
preview window.
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Printing Call
Tickets
You can print the current Call
Ticket from Call Logging. A
Call Record must be saved
before it can be printed.

Print a Call Ticket

Select Print>>Call Ticket
from the File menu.

Select a Print Quality, if
your printer offers a choice.

Type the number of copies
to print in the Copies field.

Check Collate Copies to
collate multiple pages (if
available).

Click Setup if you want to
specify a different printer.

Select the parts of the Call
Record to print from the
Sections to Print box.

Select a spacing option in
the Section Spacing box.

Select key items to print
above each Call Ticket from
the Header Info box.

Click OK.

TRY THIS
Set up custom Call Ticket printing
using AutoTask. See �AutoTask,�
Chapter 8.
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Print Call Tickets for
a Call Group

Select Print>>Group from
the File menu.

Select a Print Quality, if
your printer offers a choice.

Enter the number of copies
to print in the Copies field.

Check Collate Copies to
collate multiple pages (if
available).

Click Setup to change the
printer settings.

Select the parts of each Call
Record to print.

Select a spacing option.

Select the items you want
printed above each Call
Ticket.

Click OK.

Printing Call
Tickets for a
Call Group
You can print a Call Ticket for
each Call Record in the current
Call Group. A Call Record
must be saved before it can be
printed.
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Print a Report

Select Print>>Report from
the File menu.

Click Browse to select a
report, or select one from
the drop-down menu.

If you check the Set as
Default Report check box,
this report appears in the
drop-down box.

Click Printer.

Click Setup to change the
printer if you don�t want to
print from the default printer.

Click Print.

Printing
Reports
After you create reports with
Crystal Reports, you can print
them from Call Logging.
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Printing by
Call Type
Print By Call Type prints
Crystal Reports based on the
currently displayed Call
Record. It uses a separate
Crystal Report for each call
type and prints the report to a
specific printer. For example,
you can use this print method
to set up a report for all
Software Call Tickets and
print them to the HP LaserJet
IV in your department.
The Call Type reports must be
defined in Crystal Reports
before you can print by call
type. Your system
administrator can tell you
which reports are available in
your system.

Print a Call Type

Select Print>>By Call Type
from the File menu.

Click Browse to select a
report, or select one from the
drop-down menu.

If you check the Set as
Default Report check box,
it will set this report as the
default when printing.

Click Printer.

Click Setup to change your
printer settings, if necessary.

Click Print.6
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AutoTask
IN THIS CHAPTER

Running an AutoTask

Creating Folders

Creating Tasks

Creating Alarms

Sending Messages

Running Programs

Writing Files to Disk

Printing Call Ticket
Information

Creating Activity Log
Records

Creating Calls

Creating Assignments

Creating Journals

Updating Calls

Editing Tasks and Actions

Creating Toolbar Buttons
and Menus

Inserting Variables into
Actions

AutoTask lets you link a series of actions to a task.
With one click, AutoTask follows a series of steps
that you have defined, saving you time and effort.

You may often perform tasks such as sending e-mail,
paging, and running reports. With AutoTask, you can
define the Actions you need to accomplish, combine them
in a Task, and run the Task from a button on the toolbar.
AutoTask automates the process of creating an Activity
Log, printing a Call Record, or writing information to a file.
AutoTask can update Call Records and create new Call
Records.
You can set up a Task to perform one or more steps.
AutoTask will follow any set of logical Call Logging
instructions.
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Running an
AutoTask
You can run an AutoTask
three ways.

From the AutoTask window,
you can run a Task against the
current Call Record or the
current Call Group.

From the menu, you can run a
Task against the current Call
Record.

From the toolbar, you can run
a Task against the current Call
Record.

You can see different
AutoTasks in different views.

� The Personal view displays
your personal AutoTasks.

� The Team view displays all
AutoTasks associated with
the selected team.

� The Global view displays all
the AutoTasks created in
the Global view.

� The All view displays
personal, primary team,
and global AutoTasks.

Run a Task from the
AutoTask Window

Select Run/Edit a Task from
the AutoTask menu.

Select the view where the
Task is saved. If you select
the Team view, choose a
team from the drop-down
box.

Select the Task you want to
run.

To run the Task against the
current Call Record, click
Run.

To run the Task against the
current Call Group, click
Group Run.

Click OK.
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Run a Task from the
Menu

Select an AutoTask item
from the AutoTask menu.

Run a Task from the
Toolbar

Click the toolbar button
associated with your Task.

TIP
You can set up frequently used
tasks on the Call Logging toolbar or
AutoTask menu for easy access.

SEE ALSO
Creating Toolbar Buttons and
Creating Menu Items to Run
Tasks, in this chapter.
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Creating
Folders
You can organize your
AutoTasks in folders. This
procedure explains how to
create a folder.

Create a Folder

Select Run/Edit a Task from
the AutoTask menu.

Click New Folder.

Type a name for the folder.

Click OK. The new folder
appears in the AutoTask
window.

3
4

2

1

4

3

2

1



AUTOTASK   8-5

Creating Tasks
An AutoTask is a task that
contains one or more actions.
When you create an AutoTask,
you must first name the task
and save it. After that is
completed, you can start
adding the actions the task
will perform. The following
steps show you how to begin
setting up a task.

Create an AutoTask

Select Run/Edit a Task from
the AutoTask menu.

Click a view where the new
task will appear.

To see empty folders, click
Show Empty Folders.

Select a folder where the
new task will be stored.

Click Add.

Go to the next page.

TIP
You can save a task in a personal
view, in team view for a team you
belong to, or a global view. You can
see all of these views by clicking All,
but you cannot save to the All view.

3

5

1

2

4

6

5

4

3

2

1



8-6   CALL LOGGING AT A GLANCE

Create an AutoTask

Type a name for this Task.

If you want this task to
appear on the menu, click
Display on menu.

Select the view where this
Task will be saved. If you
select the Team view, select
a team from the drop-down
box.

Click Add. The Specify
Action Type dialog box
appears.

Select the first Action to be
performed by this Task.

Click OK. See the following
pages for instructions for
each Action. Depending on
your security rights, the
following Actions can appear
in the Specify Action Type
dialog box.

After you create the Task,  add
an Action. A task can have one
or more actions, but each must
be set up separately.
You can add any of the
following Actions, as
described on the next few
pages:

� Create an Alarm

� Send a Message

� Run a Program

� Write a File to Disk

� Print Call Ticket
Information

� Create Activity Log
Record

� Create a Call

� Create an Assignment

� Create a Journal Entry

� Update a Call
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Creating
Alarms
Use an alarm to remind you to
perform a Task or to mark a
time interval. For example, you
can set an alarm to warn you
that 5 minutes have elapsed
since you began a Customer
call. You can set alarms to
remind you to call a customer,
attend a meeting, or  any other
activity. You can also attach a
Call Record to an alarm.

Create an Alarm

Select Create an Alarm.

Click OK.

Set the time when the alarm
will go off after the task runs.

Set the calendar you wish
to use.

Type a Subject name for
this alarm.

Type any descriptive text
about this alarm.

Check the Attach Current
Call box to attach a copy of
the currently active call to
this alarm.

Click Insert to add call
information to the alarm.

Click OK.

SEE ALSO
Complex Tasks, Inserting Variables
and Additional Information, in this
chapter.
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Sending
Messages
AutoTask can send a message
to SupportMail or any VIM- or
MAPI-compliant mail system.
Your system administrator can
tell you which mail system
your company uses.
You can set up a message to
send to a specific recipient,
such as Joe Smith. You can
also insert a field code that
sends the message to
recipients based on variable
Call Information, such as
{Asgnmnt.Assignee}.
You can attach a Call Record
only to a SupportMail
message.

Send a Message

Select Send a Message.

Click OK.

Click Address.

Select the mail system.

Double-click the recipient.

Type the message subject
in the Subject field.

Type the message in the
Notes field.

Click Insert to add variables
to a field.

Click the Attach Current
Call check box to attach the
currently displayed Call
Record to a mail message.

To save this message in your
Outbox for later reference,
click Save to Outbox.

Click OK.SEE ALSO
Complex Tasks, Inserting Variables
and Additional Information, in this
chapter.
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Type or select an address in the CC
field to send a courtesy copy.
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Forwarding
Unread
Messages
Sometimes an important
message must be read within a
particular timeframe. If the
primary recipient doesn�t read
the message, another
individual should read it.
With AutoTask, you can send
a message that is forwarded to
another person, if the primary
recipient doesn�t read it within
a specified time.
This feature works only with
SupportMail, although you
can forward a message to any
VIM or MAPI address.

Forward a Message

Click Forward if Unread.

Check the Forward if
Unread check box to
activate the dialog box.

Click Address.

Select the mail system.

Double-click the recipient.

Set the amount of time that
should elapse before this
message is forwarded.

Set the calendar to use.

Click Insert to add
information to the recipient
list.

Click OK.
SEE ALSO
Attaching a File, and Inserting
Variables and Additional
Information, in this chapter.
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Attaching Files
to Messages
When you send an e-mail
message, you can attach a file
that gives the recipient more
information about a particular
Call Record.
File attachments are only
supported by VIM or MAPI
systems.

Attach a File

Click Attachments.

Type the path of the file or
click Browse to navigate to
the file location.

Click Insert to insert
variables, such as filenames
or counters.

Click OK.

Click OK.

1

SEE ALSO
Complex Tasks, Inserting Variables
and Additional Information, in this
chapter.
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Running
Programs
Use Run a Program to launch
a program. For example, you
can set up a Task to run a
paging program to page your
assignee. This function can
launch file types such as .exe,
.bat, and .com.
You can add arguments  in the
Run a Program dialog box. An
argument is any input that a
program needs to run. For
example, if you have a
program that dials a pager,
that program may require the
pager number as an argument.
Not all pager programs accept
arguments.

Run a Program

Select Run a Program.

Click OK.

Click Browse and navigate
to the program file.

Define any arguments you
want to pass to the program.

Type a directory path if
your program must be run
from a specific directory.

Type the number of
seconds the program should
wait after being launched.
This keeps temporary files
from being deleted too soon.

Click Insert to add
additional information.

Click OK.
SEE ALSO
Complex Tasks, and Inserting
Variables, in this chapter.
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Writing Files
to Disk
Use this function to capture
files or temporary files for
further use.

Write a File to Disk

Select Write a File to Disk.

Click OK.

Enter a file name, or click
Browse to navigate to a file
name.

If you want to convert this file
to Rich Text Format, click
Write in RTF Format.

If you want to add this
information to a file, click the
Append to existing file
check box. The previous
information will not be
overwritten.

Type the information you
want written to the file.

Use the formatting toolbar to
format an .rtf file.

Click Insert to add variables
to a field.

Click OK.

SEE ALSO
Complex Tasks, and Inserting
Variables, in this chapter.

TRY THIS
Capture Call Record information,
write it to a temporary file, then
pass it to an assignee�s pager. The
Call Record information appears on
the pager. This gives the assignee
the customer�s Call Record, along
with a request to call the customer
back.
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Printing Call
Ticket
Information
With this function, you can
print selected fields of the
current Call Record instead of
printing the entire Call Record.

Set up Printer

Select Print Call Ticket
Information.

Click OK.

Select either the default
printer or a specific printer
to use when printing this
information.

� Default: Use the default
printer.

� Specify: Select any printer
in your system. If you
select Specify, click
Printers and select a
printer from the Printer
Setup dialog box.

Click Insert to add
information.

Set up formatting.

To set up a page, click Page
Setup. Use the standard
windows setup boxes.

Click OK.

SEE ALSO
Complex Tasks, and Inserting
Variables, in this Chapter.

TRY THIS
Click Insert to insert any fields from
the call ticket that you want to
include in the printout. After
typing your text, you can format it
using the standard text formatting
toolbar above the message field.

6

4

7

5

3

1

2

7

6

4

5

3

2

1



8-14   CALL LOGGING AT A GLANCE

Creating
Activity Log
Records
When activated by your
system administrator, the
Activity Log tracks activity
within a Call Record.
For example, Call Logging
creates an Activity Log record
whenever the Stopwatch
starts. An Activity Log tracks
the name of the Tracker who
has the Call Record open, the
status of the record at that
time, the number of minutes
that the tracker worked on the
record, and other information.

Create an Activity
Log Record

Select Create Activity Log
Record.

Click OK.

Select the type of record.

Select the duration of the
activity.

Select the calendar to use
for the duration cycle.

Type a description of this
activity.

Click Insert if you want to
add information to the log.

Fill in any remaining fields.
Your system administrator
defines which fields appear
on this window so your
screen may look different
from our example.

Click OK.

SEE ALSO
Complex Tasks, Inserting Variables
and Additional Information, in this
chapter.

TRY THIS
When you send a Call Record to a
tracker, you may want to create an
Activity Log record to note when it
was sent.
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Creating Call
Records
You can use AutoTask to
create a Call Record template
that already has fields filled
in. For example, create a Call
Record template with the
Cause Type, Call Description
and Solution already set up in
the Call Record.
A lightning bolt next to the
field name identifies it as a
required field. When you
create a Call Action, supply a
data value to each required
field. If a required field has a
default data value of
�System,� you do not have to
supply a data value.
For new calls, you can create a
new Call Record, use the
current one, or ask for a
prompt.

Create a Call Record

Select Create Call.

Click OK.

Select a New Call option for
opening the Call Record.

� Always create a new call
creates a new Call Record
each time the AutoTask
action is launched.

� If the current call is new
call, then use it uses the
new Call Record when the
AutoTask action is
launched.

� If the current call is a new
call, ask prompts HEAT to
ask which Call Record to
use when the AutoTask
action is launched.

Make a selection from
Options.

Select a table.

Choose a field for which you
want to specify a value.

Click Validate, if available.

Double-click a data value, if
available.

Go to next page.

TIP
Use the Insert button to add
information to the currently
selected field.
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Create a Call Record

Select an overwrite option
from the field�s drop-down
box. Yes overwrites existing
values. No writes values in
blank fields.

Repeat steps 6-10 for each
field for which you want to
specify a value.

Click OK.

TIP
Use the Insert button to add
information to the currently
selected field. The button is active if
the field contains data.
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Creating
Assignments
You can use AutoTask to
create an Assignment.
If you select the Acknowledge
Assignment option or the
Resolve Assignment option,
the data value changes in
some fields.

1

Create an
Assignment

Select Create Assignment.

Click OK.

Make a selection from New
Assignment to open the
Assignment.

� Always create a new
assignment creates a new
assignment each time the
AutoTask action is
launched.

� If the current assignment
is new, then use it uses the
new assignment when the
AutoTask action is
launched.

� If the current assignment
is new, ask prompts HEAT
to ask which assignment to
use when the AutoTask
action is launched.

Make selections from
Options. These options may
change default data values in
some fields.

Select a field for which you
want to specify a value.

Go to next page.
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Click Validate, if available.

Double-click a data value, if
available.

Select an overwrite option
from the field�s drop-down
box. Yes overwrites existing
values. No writes values in
blank fields.

Repeat steps 5-8 for each
desired field.

Click OK.

TIP
When the Insert button is active,
you can use it to add information to
the Assignment.
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Creating
Journals
You can use AutoTask to
create a Journal entry.

Create a Journal

Select Create Journal.

Click OK.

Make a selection from New
Journal Entry to open the
Journal Entry.

� Always create a new
journal entry creates a new
journal entry each time the
AutoTask action is
launched.

� If the current journal is a
new call, then use it uses
the new journal entry when
the AutoTask action is
launched.

� If the current journal is
new, ask prompts HEAT to
ask which journal entry to
use when the AutoTask
action is launched.

To save the Call Record
when it is completed, click
Save call when done.

Select a field for which you
want to specify a value.

Click Validate, if available.

Go to next page.
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TIP
When the Insert button is active,
you can use it to add information to
the Call Record.

Double-click a data value, if
available.

Select an overwrite option
from the field�s drop-down
box. Yes overwrites existing
values. No writes values in
blank fields.

Repeat steps 5-8 for each
desired field.

Click OK.
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Updating Call
Records
You can use AutoTask to
update Call Records.
Fields with a �System� data
value cannot be edited.

Update a Call Record

Select Update Call.

Click OK.

Close or save the Call
Record when you are
finished.

Select the table you want to
modify.

Select a field for which you
want to specify a value.

Click Validate, if available

Double-click a data value, if
available.

Select an overwrite option
from the field�s drop-down
box. Yes overwrites existing
values. No writes values in
blank fields.

Repeat steps 5-8 for each
desired field.

Go to the next page.

TIP
When the Insert button is active,
you can use it to add information to
the Call Record.
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Update a Call Record

Select the Subset table.

Go to the first field for which
you want to specify a value.

Click Validate, if available.

Double-click a data value, if
available.

Select an overwrite option
from the field�s drop-down
box. Yes overwrites existing
values. No writes values in
blank fields.

Repeat steps 12-15 for each
desired field.

Select the Detail,
Assignment or Journal
table. Other options are
available for Assignments and
Journals.

Repeat steps 12-16 for any
other fields you desire.

Click OK.

TIP
When the Insert button is active,
you can use it to add information to
the Call Record.
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Editing Tasks and Actions
You can add more Actions to create a complex Task. A Task
can contain a series of Actions. It performs each Action in
order. The following scenarios illustrate AutoTask�s power.

Follow-up Calls

You often schedule follow-up calls with your customers for a
specific time frame, such as promising to call them after four
hours. Define a four-hour alarm in AutoTask and associate
the Task with a button on your toolbar. Include an activity log
record so that each time you use the alarm, the Activity Log
records the Action.

Form Letters

You can use a form letter to send a customer satisfaction
survey to your customers. Design the letter with print
options.

Remote Control

You use remote control software to take control of a
customer�s workstation for troubleshooting and repair. Track
the IP address in the HEAT system and launch your remote
control software with the proper arguments from the Call
Logging screen. Track your use of remote control in the
activity log, and you can report how many times you used
remote control, and for which customers.

E-Mail

You often send similar e-mail messages to your customers,
updating them on the status of their issues or giving them
written solutions. Define the message to be sent, insert field
data, send it to an e-mail ID from a customer profile, and have
the activity log record when the message is sent. You can
perform the entire Task with the touch of a button.

Paging

You often page your technicians to alert them to important
issues. Use AutoTask with your server paging software tool
to send the information they need. Have the activity log track
when the page is sent.

Call Tickets

You need one type of printed Call Ticket to give to your
internal technicians, and another type for a printed work
order going to your vendor. Customize your output using
Crystal Reports and associate it with a button on your
toolbar.

Call Templates

Set up templates for calls that come in frequently, such as
Password Change or Printer Jam.
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Creating
Complex
Tasks
A complex Task contains two
or more Actions. When you
run the Task, it performs each
of the Actions in serial order.
After you create a Task and
add an Action, you can add
another Action.
You can add many Actions to
any Task.

Add an Action to a
Task

Select a Task.

Click Edit.

Click Add.

Select an Action.

Click OK.

Repeat steps 2-5 for each
action you want to add.

Click OK.

Click Close.
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Changing
Action Order
When you run a Task, it
performs its Actions in the
order they are listed in the
Actions window. You can edit
the order in which the Actions
are performed.

Change Action
Order

Select Run/Edit a Task
from the AutoTask menu.

Select the view where the
Task is saved.

Select the Task.

Click Edit.

Select the Action to be
moved.

Click the Up or Down arrow
to move the item up or down
one level in the window.

Click OK.

Click Close.
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Removing
Tasks
You can remove a Task from
the Task List.

Remove a Task

Select Run a Task from the
AutoTask menu.

Select the view where the
Task is saved.

Select the Task.

Click Delete.

Click OK.

Click Close.
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Editing
Actions
You can edit an Action to
change information or add
new information.
You can also remove an
Action.

Edit an Action

Select Run/Edit a Task from
the AutoTask menu.

Select the view where the
Task is saved.

Select the Task containing
the Action to be edited.

Click Edit.

Select the Action to be
edited.

To remove the Action, click
Remove.

To edit the Action click Edit.

Go to next page.
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Edit an Action

Edit the Action. (You can
change any attribute in any
field.)

Click OK.10
TIP
When the Insert button is active,
you can use it to add information to
the action.

SEE ALSO
Inserting Variables and Additional
Information, in this chapter.
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Creating
Toolbar
Buttons to Run
Tasks
You can create a toolbar button
to run an AutoTask against the
current Call Record.
You can put the button on the
toolbar or in the Update Tools
collection. The Update Tools
collection only adds the button
to the Toolbar Customize
window; it does not place the
button on a toolbar. If you put
the button in the Update Tools
collection, you must select it
from the Toolbar Customize
window to put it on the
toolbar.

Create a Toolbar
Button

Select Run/Edit a Task from
the AutoTask menu.

Select the view where the
Task is saved.

Browse through the folders
to select the Task you want
to put on the toolbar.

Click Associated Toolbar
Button.

Select an icon to place on
your toolbar button or click
None to leave the toolbar
button empty.

Select a toolbar option:

� Put on Toolbar Immediately
puts the button on the
toolbar.

� Update Tools Collection
Only adds the button to the
options in the Toolbar
Customize window.

Click OK.

Click Close.

SEE ALSO
Customizing the Toolbar in  �Call
Logging,� Chapter 2.
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Creating Menu
Items to Run
Tasks
You can create a menu item
that runs an AutoTask against
the current Call Record.

Create a Menu Item

Select Run/Edit a Task from
the AutoTask menu.

Select the view where the
Task is saved.

Select the Task you want to
put on the menu.

Click Edit.

Click Display on Menu.

Click OK.

Click Close.
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Inserting Variables and
Additional Information into
Actions
Several AutoTask windows have an Insert button which you
can use to display the Insert menu. The button is unavailable
until you activate certain fields, which differ from screen to
screen. Use the Insert menu to add variables and additional
information to an AutoTask Action.

You can insert the following types of variables:

Field

The value of a field or an @function, such as the current date.

Filename

Inserts a file name variable, which will be replaced with a
real file name.

Insert Button Insert Menu

Temporary Filename

Inserts a temporary file name, which will be replaced with a
permanent file name.

All Assignments

Inserts all assignments from the Call Record.

All Journals

Inserts all journal entries from the Call Record.

Insert Blank Value

Inserts blank data to blank out empty fields. Be sure to set
overwrite to Yes.

Insert New Line

Inserts a line break.

Insert Counter

Inserts an automatic number generator..

The procedures on the following pages show how to add
each type of variable. Each procedure begins with the Insert
menu.
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Inserting
Fields
Use Insert Field to add fields
with variable information.
For example, you can set up a
generic template to page
assignees when calls are
assigned to them. If your
company has many assignees,
any one of them can receive the
message. If you insert a field in
the template, the Action
automatically pages the person
listed as the assignee in the
Call Record.
The Insert Field dialog box
contains all table and field
types in a Call Record,
including Customer Profile
data, and general functions for
variables such as the current
date.
When running a task against a
Call Group, you can elect to
have information come from a
master record (the currently
selected Call Record of the
current group) instead of the
current Call Record.

Insert a Field

Select Insert Field.

Select a Table.

Select a Field. (If you select
@Function, you may need
to select a format or prompt.
See next page.)

If you will run this task
against a group, click the
check box to use
information from the group�s
starting record instead of the
current Call Record.

Click OK. The table type and
field type appear in the field.

1

4

2 5

3

5

4

3

2

1

SEE ALSO
@Functions, in this chapter and in
Appendix C.
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Format a Date Field

Select @Functions from the
Table drop-down box.

Select @Current Date from
the Field drop-down box.

Select a date format from
the Format drop-down box.

Click OK.
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Inserting
@Functions
@Functions are fields that let
you customize data based on
variable criteria. For example,
you can set up an AutoTask to
insert the current date (see
example).
Select from the following
@Functions:
�@Current Date
�@Current Time
�@Prompt()
�@TrackerSupervisor
�@UserID()
�@DateAdjust()
�@DDERequest()
�@TimeAdjust()

�@ReadFile()

TRY THIS
Use the @TrackerSupervisor
function to automatically notify a
supervisor of an upcoming deadline.

SEE ALSO
@Functions, Appendix C.

TRY THIS
Use the @Prompt() function to
automatically notify you of a call
that needs updating.
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Inserting File
Names
The Insert Filename feature is
used to insert file names that
are common within several
Actions for an individual Task.
For example, if you want to
run a particular text file, you
could set up the field as
follows:

{|Filename1}.TXT
The file names are assigned by
HEAT and are unique (for
example, HFW1234, HFW
1235, etc.). The file names are
stored locally and remain the
same for all Actions within an
AutoTask item.

Insert a File Name

Select Insert Filename.

Select a generic file name
from the list.
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Inserting
Temporary
File Names
You can use this feature when
you run a program that
requires a temporary file. For
example, when you run the
pager utility, assign a
temporary file name to the
message.
After the AutoTask item is run,
the temporary file name is
deleted. The temporary file
name appears like this:

{|Temporary file1}
Temporary file names are
unique and have full paths,
such as:

C:\temp\hfw1237.tmp
SEE ALSO

Insert a Temporary
File Name

Select Insert Temporary
Filename.

Select a generic temporary
file name from the list. 2
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Inserting
Assignments
and Journals
Select Insert All Assignments
to display the information for
all Assignment records in a
call. The field appears as:

{|All Assignments}
Select Insert All Journals to
display the same information
for all Journal records in a call.
The field appears as:

{|All Journals}

Insert All
Assignments

Click Insert All
Assignments. The All
Assignments expression
appears in the selected field.

Insert All
Journals

Click Insert All Journals.
The All Journals expression
appears in the selected field.

TIP
Before inserting Assignments or
Journals, establish the format by
clicking �Edit Blocks.�

SEE ALSO
Editing Blocks, in this chapter.
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Inserting
Blank Values
Select Insert Blank Values to
overwrite empty fields with
blank data. Be sure to set the
overwrite option to Yes in the
Specify Action dialog box.

Insert Blank Value

Click Insert Blank Value.
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Inserting New
Lines
Select Insert New Line to insert
a line break in the body of text.

Insert New Line

Click Insert New Line. A
line break appears in the
selected field.
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Inserting
Counters
Select Insert Counter to
automate number generation.
For example, use a counter to
automatically generate an
RMA number in a Quick Call.
Counters are set up by your
system administrator. Your
ability to modify counters is
based on your security role,
but you can modify some
parameters within Call
Logging.

Insert Counter

Click Insert Counter.

Select a counter (an RMA
counter is used in this
example).

1

2

1
2

SEE ALSO
Formatting Counters, in this
chapter.
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Formatting
Counters
You can format counters to
display numbers differently.
Your ability to modify counters
is based on your security role.

Format Counter

Click Insert Counter.

Select Format Counter. The
Format Counter dialog box
appears.

Click Increment the
number when used to
automatically increment the
number after it has been
used.

Click Pad number with 0s
to place 0s before the
number.

Select the total width of the
number. (For example, if you
choose 6 as the width of the
number, the generated
number will be a total of 6
digits.)

Click Split the number
every x digits to insert a
character between digits.

Select a splitting number.

Select the splitting
character.

Click OK.
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TIP
Use �Increment the number when
used� option to prevent a number
from being used twice.

TIP
Use a splitting character such as a
hyphen to break up a long number.

For example, 123456 becomes
123-456.
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Edit a Block

Click Edit Blocks.

Type text or insert variables
in the Assignment Block or
Journal Block.

Click OK.

Editing Blocks
Use the Edit Blocks to specify
the text and formatting of All
Assignments and All Journals.
You can change formatting
preferences, edit text, insert
fields, and change alignment.
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Sharing
Information

IN THIS CHAPTER

Alert Monitor

Start-up Menu

Defining Call Group Alerts

Alert Definitions

Polling

Acknowledging
Assignments

At or Away From Your Desk

Alerts for SupportMail

Message Alerts

SupportMail

Broadcast Messages

HEAT contains numerous ways to share
information. Alert Monitor lets you set up
alerts to notify you each time you get a call or

assignment. SupportMail lets you exchange information
with other support center workers.
� Alert Monitor � Tell Alert Monitor when, where, and

how to alert you and others about new calls or
assignments.

� SupportMail�Exchange e-mail messages with others
on internal or external mail systems. You can also
send broadcast messages to everyone on your mail
system.
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Logging on to
Alert Monitor
You can start Alert Monitor
from a desktop icon or from
the Start menu.

Log on to Alert
Monitor

Select Programs>>
HEAT>>Alert Monitor from
the Start button.

Select the data source from
the drop-down list.

Click OK.

Enter your User ID and
Password.

Click OK. The start-up menu
appears.
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Using the
Startup Menu
Alert Monitor�s start-up menu
displays the module
components, explains their
purpose, and lets you access
them quickly.
You can enable and disable
the startup menu.

Run an Alert Monitor
Task

Highlight a task. An
explanation of the task
appears in the text pane.

Click OK to run the
highlighted task.

Show or Hide the
Start Menu

To hide the start menu, click
Do not show this start-up
menu again.

Click Close.

To display the start menu,
click the Start Menu icon.
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Defining Call
Group Alerts
Alert Monitor can notify you
when certain events occur in
selected Call Groups. The first
setup step is to define these
Call Groups and the events to
which you or others will be
alerted.
Alert Monitor can notify you
when it detects:

� A new call assigned to you
or your group.

� A new SupportMail, or
VIM or MAPI e-mail.

� An alarm is tripped.

SEE ALSO

Define a Call Group
Alert

Select New from the File
menu.

Click New.

Type a title for this new Call
Group Alert. The default title is
the call group name.

Click Browse.

Select the view where the Call
Group is stored.

Select the Call Group.

Click Open.

Select the conditions that you
want to be notified of:

� Any calls are Found in the
selected Call Group.

� Any Calls are Added to the
selected Call Group.

� Any Calls are Removed from
the selected Call Group.

Click OK.

Click Exit. The new Call Group
Alert appears in the Alert
Monitor window.

SEE ALSO
Creating a New Call Group in
�Call Groups,� Chapter 4.
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Defining What
Alert Monitor
Does
The second setup step is to
define what Alert Monitor
does when your selected
events occur in your selected
Call Group.
You can receive notification of
events when you are at, or
away from, your desk.
Alert Monitor can send a
message to a computer or
pager. It can:

� Sound an alert on a
computer running Alert
Monitor.

� Send an e-mail message.
� Page someone using

third-party paging
software.

Go to the Call Group
Alert Action Screen

From the Call Group
Definition Window, select
Define>>Call Group Alert
Action. The Call Group
Alert Action screen
appears.

Note: The procedures on the
next four pages show how to
fill in this screen.

1 1
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TIP
If you have a sound card, select a
unique sound file, so you will know
the message is from Alert Monitor.

Set up Alert Monitor
to Make a Sound on
Your Computer

Click the Sound check box.

To produce a system beep,
click the System Beep radio
button.

To produce another sound,
click the File radio button.

Click Browse.

Select a .wav file.

Click Open.

The .wav file appears in the
File field.
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TIP
Be sure to set your e-mail program
to alert you when new e-mail
arrives.

Set up Alert Monitor
to Send an E-Mail
Message to Your
Computer

Click Address.

Select a mail system from
the Mail System drop-down
box.

Click your name.

Click OK.4

2
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SEE ALSO
Setting Up External E-mail in
�User Preferences,� Chapter 10.
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SEE ALSO
Sending a Page, in this chapter.

Set up Alert Monitor
to Run a Program on
Your Computer

Click Browse.

Select an executable file to
launch as an alert. For
example, you can launch
your paging utility.

Click Open.

Define arguments to pass
to the program in the
command line. For example,
you can enter your pager
number.
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SEE ALSO
Sending a Page, in this chapter and
�User Preferences,� Chapter 10.

Set up Alert Monitor
to Page You

Click the Send Page check
box. Note that the Send
Page check box is enabled
only if you have previously
defined the paging command
line in the User Preferences
dialog box.
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SEE ALSO
Sending a Page, in this chapter.

Set up Alert Monitor
to Send an E-Mail
Message to a Pager

Click Address.

Select a mail system from
the Mail System drop-down
box.

Click the name of the
person to be paged.

Click OK.
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Set up Alert Monitor
to run a Program as
an Alert

Click Browse.

Select an executable file to
launch as an alert. For
example, you can launch
your paging utility.

Click Open.

Define arguments to pass
to the program in the
command line. For example,
you can enter your pager
number.

Click OK.

SEE ALSO
Sending a Page, in this chapter.
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Edit a Call Group
Alert Definition

Select Call Group Alerts
from the Define menu.

Select a Call Group Alert
Definition.

Click Edit.

Edit the attributes of the
Call Group Alert Definition.

To modify the fields in grid
view, click Grid.

To move an available field to
the list of selected fields,
highlight the field and click
Add.

To remove a selected field
from the list of selected
fields, highlight the field and
click Remove.

Click OK.

Click OK.

Click Exit.

Editing Call
Group Alert
Definitions
You can edit the attributes of a
Call Group Alert Definition.
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Delete a Call Group
Alert from the List

Select a Call Group.

Click Delete.

Click Yes.

Click Exit.

Deleting Call
Group Alerts
from the List
You can delete a Call Group
from the Alert Definition list.
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Defining How
Often Alert
Monitor
Checks for
Calls
The polling interval
determines how often Alert
Monitor checks the database
for Call Group or messaging
changes.

Define the Polling
Interval

Select Polling Interval from
the Define menu.

Select the type of interval
(in minutes or hours) from
the drop-down box.

Enter the numerical
interval in the number field.

Click OK.4
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Starting and
Stopping
Polling
When you have set up Alert
Monitor, you can start polling
the database for alert
messages. When you start
polling, HEAT waits for the
prescribed polling interval,
then polls the database.
You can also poll the database
on command.

Start Polling

Select Start from the
Options menu. A green light
on the signal icon means
that polling is active.

SEE ALSO
Defining How Often Alert Monitor
Checks for Calls, in this chapter.

Stop Polling

Select Stop from the
Options menu. A red light
on the signal icon means
that Alert Monitor is not
polling.

Poll Now

Select Poll Now from the
Options menu.
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Acknowledging
Alert Monitor
Assignments
You can acknowledge an
assignment while running
Alert Monitor. The control is
enabled only if an assignment
exists.

Acknowledge an
Assignment

When Alert Monitor
announces a new
assignment, select
Acknowledge Assignment
from the Options menu.
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Telling Alert
Monitor When
You are Away
From Your
Desk
When you set up Alert
Monitor, you defined how you
will be notified of alerts, both
at and away from your desk.
With this procedure, you can
tell Alert Monitor when you
are at or away from your desk.

SEE ALSO
Defining what Alert Monitor Does,
in this chapter.

Tell Alert Monitor
You are away from
Your Desk

Select Away from my
desk from the Options
menu. The Away from My
Desk icon shows an empty
desk.

Tell Alert Monitor
You are back at
Your Desk

Select Away from my
desk from the Options
menu. The At My Desk icon
shows a person at the
desk.
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Launching
Call Logging
from Alert
Monitor
From Alert Monitor, you can
launch Call Logging in one of
three modes:

� Launch Call Logging
launches Call Logging.

� Launch Call Logging for
Call ID launches Call
Logging open to the Call
Record currently selected
in the Alert Monitor
window.

� Launch Call Logging for
Call Group launches Call
Logging open to the Call
Group of the Call Record
currently selected in the
Alert Monitor window.

Launch Call Logging

Select Launch Call
Logging>>Launch from the
Options menu.

Launch Call Logging
Open to the Current
Call Record

Select the Call Record you
want to view from a Call
Group Details window.

Select Launch Call
Logging>>Call ID from the
Options menu.
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TIP
This procedure launches Call
Logging with the highlighted Call
Record displayed.

Launch Call Logging
Open to a Call
Group

Select the Call Group you
want to view from the drop-
down box.

Select Launch Call
Logging>> Call Group:
from the Options menu.
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Save Alert Monitor
Definitions

Select Save from the File
menu.

Type a file name in the File
name field.

Click Save.

Saving Alert
Monitor
Definitions
You can save Alert Monitor
definition settings as separate
files. This lets you have your
own Alert Monitor definitions.
You can save multiple
definition files. For example,
you may have one set of call
groups to monitor during the
week and another set on the
weekend.
Alert Monitor saves the file
with the extension .alr.
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View the Alert
Summary and
Details

Select Alert Summary from
the View menu.

To view a Call Group�s
details, double-click the Call
Group.

To view a Call Record in Call
Logging,  double-click the
Call Record.

Viewing Alert
Summaries
and Details
After a poll you can view the
Alert Summary. The Alert
Summary shows each Call
Group and the number of
alerts generated, added, and
removed. A red bell icon
appears for a current alert.
Each Call Group Details
window displays the selected
Call Group and all Call
Records that meet the alert
criteria. It displays all calls in
the call group regardless of
which ones tripped the alert.
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View a Call Record�s
Journal Entries

Select Journals from the
View menu. A list of Journal
entries for that Call Record
appears.

Select the Call Record
from the list of Call Group
Details.

Viewing Lists
of Journal
Entries
You can view a list of all
Journal entries associated with
a Call Record. 2

1

1

2



SHARING INFORMATION   9-23

Setting Alerts
for SupportMail
You can specify how Alert
Monitor notifies you of
SupportMail messages.

Set Unread
SupportMail
Notification

Select System Message
Alerts from the Define
menu.

To be notified of new
SupportMail messages when
you are at your desk, click
the At My Desk check box.
To be notified of new
SupportMail messages when
you are away from your
desk, click the Away From
My Desk check box.

Click Action.

Fill out this form as shown in
Defining What Alert
Monitor Does, in this
chapter.

1

3
2

4

1

2

3

4

Defining What Alert Monitor Does,
in this Chapter.

SEE ALSO
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TIP
You may have alarms defined in
Call Logging. You may use this
procedure to add or edit them.

Set Alarm Notification

Select System Message
Alerts from the Define menu.

Click At My Desk.

Click Define.

Click New.

Type a subject.

Type a descriptive note.

In the Date field, click the up
or down arrows to increase or
decrease the alarm date by
one day.

In the Time field, click the up
or down arrows to increase or
decrease the alarm time by
one minute.

Click OK.

Click Exit.

Click OK.

SEE ALSO
Defining what Alert Monitor Does,
in this chapter.
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Setting User
Preferences for
Message Alerts
You can select the means of
alert notification.
If you will use Alert Monitor to
dial your pager, set the pager
command line here.
Set the options for Alert
Monitor at start-up.

Set Alert Notification

Select User Preferences
from the Options menu.

To display the Alert
Summary dialog box as an
alert, click the Summary
Dialog button.

To display the Alert Monitor
window as an alert, click the
Restore Alert Monitor
Window button.

To display the Alert Monitor
button in the taskbar, click
the Alert Icon button.
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SEE ALSO
Set up Alert Monitor to Run a
Program on Your Computer, in this
chapter.

Specify Paging Utility

Select User Preferences
from the Options menu.

Click Browse.

Select your paging utility�s
executable file.

Click Open.

Enter your pager number, or
any other necessary
conditions for launch, in the
Arguments field.
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SEE ALSO
Starting and Stopping Polling, in
this chapter.

Set Start-up Options

Select User Preferences
from the Options menu.

To start Alert Monitor in
minimized mode, click the
Minimize Main Window
check box.

To begin checking for alerts
without a manual start, click
the Automatically Start
Polling check box.

If you will be away from your
desk at start-up, click the
Set Away From My Desk
check box.

To open an alert definition at
start-up, click Browse.

Select an alert definition.

Click Open.

Click OK.
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SupportMail
SupportMail is HEAT�s e-mail system. You can use it to
exchange e-mail with other HEAT users. You can also use it
to send and receive external e-mail messages.
You can store sent and received messages in special folders.
You can also send a broadcast message to every person on
your mail system.
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Starting
SupportMail
When you start SupportMail,
the screen displays the
messages in your in box. A
closed envelope icon identifies
an unread message. An open
envelope icon identifies a read
message. A telephone icon
identifies a message with a
Call Record attached.

Start SupportMail

Select SupportMail from the
View menu. The
SupportMail screen appears.

1

1

TIP

Add a SupportMail button  to

your toolbar for easy launching. See
Customizing Toolbars in �Call
Logging,� Chapter 2.
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Viewing E-Mail
Messages
Your messages can come from
coworkers or from automated
tools like the Business Process
Automation module. You can
also receive messages from
external e-mail sources.
Your system administrator
controls rights to send and
receive external messages.

View an E-Mail
Message

Double-click an e-mail
message.

Click the Previous or Next
arrow buttons to view other
messages.

SEE ALSO
Setting Alerts for SupportMail, in
this chapter.
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Delete an E-Mail
Message

Click Delete. The message
is deleted.

Save an E-Mail
Message

Click Save. The message is
saved.

Saving and
Deleting
E-Mail
Messages
You can save and delete
e-mail messages.
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Replying to
E-Mail
Messages
When you reply to a message,
SupportMail prepares a
Compose Message screen with
the recipient filled in.

Reply to an E-Mail
Message

Click Reply.

Type a subject for the reply.

Type the message of the
reply.

Click Send.
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Forwarding
E-Mail
Messages
Use this feature to forward a
received message to another
person.

Forward an E-Mail
Message

Click Forward.

Click Address.

Select a Mail System.

Double-click a recipient.

Repeat steps 2-4 for all
recipients and cc recipients.

Click Send.
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Sending
E-Mail
Messages
Use SupportMail to exchange
e-mail with other HEAT users,
and to send external e-mail
messages. E-mail messages
can be sent directly from
SupportMail or from the Call
Logging and Customer
Windows.

Send an E-Mail
Message  from the
SupportMail Window

Select New Message from
the File menu.

Click Address to view a list of
recipients.

Select a mail system.

Double-click a recipient.

Repeat steps 2-4 for each
recipient and cc recipient.

Type a subject.

Type the message.

Select the Attach Call check
box to attach the currently
displayed Call Record to a
SupportMail message.

To save this message in your
outbox to refer to later, click
Save in Outbox.

Click Send.
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TIP
You can forward a message if it is
not read. See Forward Unread
Messages, in this chapter.

TIP
You can attach e-mail messages and
Call Tickets. See Attaching E-Mail
Messages to Call Tickets, this
chapter.
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Send an E-Mail
Message from the
Call Logging Window

Select Mail>>Send Mail
from the Accessory menu.

Click Address to view a list of
recipients.

Select a mail system.

Double-click a recipient.

Repeat steps 2-4 for each
recipient and cc recipient.

Type a subject.

Type the message.

Select the Attach Call check
box to attach the currently
displayed Call Record to a
SupportMail message.

To save this message in your
outbox to refer to later, click
Save to Outbox.

Click Send.
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Send an E-Mail
Message from the
Customer Window

Select Send Mail from the
Mail menu in the Customer
window.

Click Address to view a list of
recipients.

Select a mail system.

Double-click a recipient.

Repeat steps 2-4 for each
recipient and cc recipient.

Type a subject.

Type the message.

Select the Attach Call box to
attach the currently displayed
Call Record to a SupportMail
message.

To save this message in your
outbox to refer to later, click
Save to Outbox.

Click Send.
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TIP
Type or select an address in the CC
field to send a courtesy copy.

9

10

9

10



SHARING INFORMATION   9-37

Attaching Call
Records to
E-Mail
Messages
SupportMail allows you to
link Call Records and e-mail
messages. Use this feature to
attach Call Records to
important messages.

Attach a Call
Records to an E-Mail
Message

Select New Message from
the File menu.

Click Address to view a list
of recipients.

Select a mail system.

Double-click a recipient.

Repeat steps 2-4 for each
recipient and cc recipient.

Type a subject.

Type the message.

Select the Attach Call box
to attach the currently
displayed Call Record to a
SupportMail message.

To save this message in your
outbox to refer to later, click
Save in Outbox.

Click Send.

1
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2

TIP
You can set up �Save to Outbox�
and �Attach Current Call� defaults
in the User Preferences dialog box.
See �User Preferences,� Chapter
10.
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View a Call Record
Attached to an
E-Mail Message

Click the Attachment
button. The attached Call
Record appears.

Viewing
Attached Call
Records
SupportMail lets you link Call
Records and e-mail messages.
You can view an e-mail from a
Call Record or a Call Record
from an e-mail.
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View an E-Mail
Message Attached to
a Call Ticket

Select Mail>>View
Attached Messages from
the Accessory menu.

Select the message you
would like to view.

Click Open. The message
appears.

1

TRY THIS
View a Call Record attached to an
e-mail directly from a Call Ticket. 1

3

2

2
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Forward an Unread
Message

Click Forward in the
Compose Message dialog
box.

To forward the message if
not all recipients read it,
click By All Recipients. To
forward the message if no
recipient reads it, click By
Any Recipients.

Click Address.

Select a mail system.

Double-click a recipient.

Set the time and date that
should elapse before the
message is forwarded.

Click OK.

Click Send.

Forwarding
Unread
Messages
You can forward a message if
it is not read by the original
recipient within a specified
timeframe.
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Sending
Broadcast
Messages
SupportMail can send a
message to every person in
your group.
The message appears on every
user�s screen.

Send a Broadcast
Message

Select Broadcasts from the
View menu.

Click New.

To attach the current Call
Record, click Attached Call.

To save this message in the
Outbox to be reviewed later,
click Save Broadcast to
Outbox.

Type a subject in the Subject
field.

Type the text of the message
in the Note field.

Set a time and date for the
message to self-delete. Any
users who log in before the
expiration time and date will
see the broadcast.

Click the up or down arrows
to set a time for the message
to self-delete.

To prevent the message from
self-deleting, mark the
Disable check box.

Click Send.

987

10

6

5

3
4

2

1

1

2

3

4

5

6

7

8

9

10



9-42   CALL LOGGING AT A GLANCE

Edit a Broadcast
Message

Select Broadcasts from the
View menu.

Select the broadcast
message to edit.

Click Edit.

Edit the fields and check
boxes as necessary.

Click Send.

Editing
Broadcast
Messages
You can edit and resend a
broadcast message. Recipients
who have read the old
message will not receive the
new message. Recipients who
have not read the old message
will receive the new message.
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Delete a Broadcast
Message

Select Broadcasts from the
View menu.

Select the broadcast
message to delete.

Press Delete. Any users
who have not yet received
the broadcast will not see it.

Deleting
Broadcast
Messages
You can delete a broadcast
message from your
workstation.
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Organizing
SupportMail
You organize your mail in
folders. You can create a folder
to hold incoming mail from a
certain person, or copies of
mail sent regarding a certain
subject.

Create a New Folder

Select New Folder from the
File menu.

Type a name for the new
folder in the Name field.

Click OK.

TIP
You can change the default names
of mail folders. See Changing Folder
Names in �User Preferences,�
Chapter 10.
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Move a Message
from One Folder to
Another

Select an e-mail message
to move.

Select Move from the
Message menu.

Select a new folder for the
message.

Click OK.

Moving
Messages from
One Folder to
Another
You can move an e-mail
message from one folder to
another.
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Copying
Messages from
One Folder to
Another
You can copy an e-mail
message from one folder to
another.

Copy a Message
from One Folder to
Another

Select an e-mail message
to copy.

Select Copy from the
Message menu.

Select a new folder for the
message.

Click OK.
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User
Preferences

IN THIS CHAPTER
Customizing the Display

Showing Call History

Counting Calls

Auto Search Interval

Tracker Information

Changing Passwords

Call History Chronology

Assignment View

Journal View

Configuration Fields

Frequency of Notifications

Alarm Options

Mail Folder Labels

Mail Format

HEAT Display Language

Default Data Source

Time Zone Offset

Paths

Sounds

HEATBoard Issues

Teams

Call Map

You can customize many settings that control the
way HEAT operates. The settings affect only your
workstation, not the entire HEAT system.

Your system administrator controls your access to many
areas of HEAT, but you can customize many of the HEAT
features to your personal preference. For example, you can
show or hide the Information Center, set sounds associated
with assignments, set external e-mail, etc.
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The Display Tab
From the Display tab, customize the Call History display, the
Call Counting Hot Keys, the Auto Search interval, and the
Tracker�s name, e-mail, and password
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Customizing
the Display
You can change the size of the
Profile Subset to view as much
or as little of the customer
information as you like. HEAT
can adjust the size of the
Profile Subset to display all
Profile Subset fields. It can
also maximize Call Group
windows automatically.
HEAT can put a check mark
on the tabs of active tab
screens (Call Log, Detail,
Assignment, and Journal). A
check mark on the tab
identifies a screen that has
information.

Customize Display

Select User Preferences
from the Edit menu.

Click the Display tab.

Click the AutoSize Subset
check box to display all
Profile Subset fields.

Click the Check Marks on
Tabs check box to put a
check mark on active tab
screens (Call Log, Detail,
Assignment, and Journal).

Click the Maximize Group
Windows check box to
maximize the windows
automatically.

Click OK.
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Viewing Call
History
HEAT can display a
customer�s Call History when
you enter a Customer ID into a
new Call Record. If a Call
Record exists for this problem,
you can update that record
rather than begin a new one.
You can configure HEAT to
display the customer�s Call
History or prompt you to go
automatically to an existing
Call Record.
You can also configure HEAT
not to show existing Call
Records.

View Call History

Select User Preferences
from the Edit menu.

Click Show Call History on
New Calls on the Display
Tab to show the Call History
when you first select a
customer for a new call.

To automatically abandon
the new Call Record if you
select an existing Call
Record from the Call History,
click If an existing call is
selected, abandon new
call without asking.

Click OK.

SEE ALSO
Setting Call History Chronology, in
this chapter.
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Counting the
Number of
Calls
If several people call about the
same problem, you do not
have to open a new Call
Record for each one. Instead,
use the Call Counter to record
the number of calls about the
problem. You can increment or
decrement the Call Counter by
pressing hot keys on the
keyboard. The Call Counter
appears in the Call Status
banner.

Change the Keys to
Count Calls

Select User Preferences
from the Edit menu.

In the Display Tab, click Use
+/- Keys to use the + and �
keys.

Click Use CTRL +/- Keys to
use the CTRL, +, and �
keys.

Click OK.

TIP
If you use the + and - keys to
change the call count, you can�t use
the numeric keypad for data entry.
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Changing
Auto Search
Intervals
You can set up HEAT to search
a knowledge base
automatically while you enter
information into a Call Record.
These searches must be
defined in the Administrator
module. Contact your system
administrator to define these
searches.

Change the Auto
Search Interval

Select User Preferences
from the Edit menu.

In the Display Tab, enter an
Auto Search interval in
seconds, or click the arrows
to change the interval.

Click OK.
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Changing
Tracker
Information
When you open a new Call
Record, HEAT enters the
default tracker�s name into the
Tracker field. You can change
the default tracker name if you
don�t want to use your own.
For example, if you want calls
logged by Call Screener Dave
to be owned by Technician
Chris, then Dave would have a
default tracker of Chris.

Set the Default
Tracker

Select User Preferences
from the Edit menu.

In the Display tab, select a
tracker name from the drop-
down box.

Type your tracker�s e-mail
address in the E-Mail Name
field.

Click OK.
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TIP
The e-mail address is used for the
tracker in the Business Process
Automation module.
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Change Your
Password

Select User Preferences
from the Edit menu.

Click Change Password.

Enter your old password in
the Old Password field.

Press Tab.

Enter your new password in
the New Password field.

Press Tab.

Enter your new password in
the Verify New Password
field.

Click OK.

Click OK.

Changing
Your Password
You can change your HEAT
password. For security
reasons, your support center
may require that you change
your password periodically.
Your password may contain
1-8 letters,  numbers, or
spaces. Passwords are case-
sensitive.
TIP

TIP
Your System Administrator can
reset a forgotten password.
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The Grid Settings Tab
From the Grid Settings tab, set Call History options, the
Assignment and Journal view and sort orders, and the fields
displayed on the Configuration screen.
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Setting Call
History
Chronology
You can sort Call History from
lowest to highest or highest to
lowest values. You can
exclude closed calls from Call
History. You can limit Call
History to a range of dates.

Set Call History
Chronology

Select User Preferences
from the Edit menu.

Click Grid Settings.

Click Ascending or
Descending to set the sort
order.

To limit the display to a
reasonable time period, click
Limit Display To Calls That
Are Not Closed.

To display the last call, click
Limit display to last.

Enter a number.

Select a time period from
the drop-down box. If you
select a date field, the time
field following will also be
included.

Click OK.

SEE ALSO
View a Customer�s Call History in
�Call Logging,� Chapter 2.
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Setting the
Assignment
View
A Call Record can have
multiple assignments. You can
set the default view as a grid
list or as forms.
In grid view a grid displays a
list of Assignments. Each row
in the Grid represents one
Assignment for the selected
Call Record.
In form view each Assignment
appears in its own full-screen
form.
You can sort the assignments
based on one of several fields
and put them into ascending
or descending order.

Select Grid or Form
View

Select User Preferences
from the Edit menu.

Click Grid Settings.

Click Grid View or Form
View to select the view.

Click Specify Order.

Select a field to sort by from
the drop-down box.

Click Ascending or
Descending to set the sort
order.

Click OK.

SEE ALSO
Viewing Assignments in �Call
Logging,� Chapter 2.

TIP
Sorting by date will also sort by the
time.
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Setting the
Journal View
A Call Record can have
multiple journals. You can set
the default view as a grid list
or as forms.
In grid view a grid displays a
list of journals. Each row in
the grid represents one journal
for the selected Call Record.
In form view each journal
appears in its own full screen
form.
You can sort the journals
based on one of several fields
and put them into ascending
or descending order.

Set the Journal View

Select User Preferences
from the Edit menu.

Click Grid Settings.

Click Grid View or Form
View to select the view.

Click Specify Order.

Select a field to sort by from
the drop-down box.

Click Ascending or
Descending to set the sort
order.

Click OK.

TIP
Sorting by date will also sort by the
time.

SEE ALSO
Viewing Journal Entries in �Call
Logging,� Chapter 2.
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Setting the
Config Fields
Displayed in
Grid View
You can specify how many
Common Configuration fields
are displayed in the
Configuration table grid.
The list box displays the fields
that will appear in the
Configuration table�s grid
view.

Set the Number of
Fields Displayed in
the Config Screen

Select User Preferences
from the Edit menu.

Click Grid Settings.

In the Common Config
Grid Display Fields box
move the slider left or right
to select the number of
displayed fields.

Click OK.

TIP
Fields are selected based on how
many different configuration
screens they appear on.
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The Mail Tab
From the Mail tab, set the polling interval for e-mail messages
and alarms, alarm options, e-mail options, and mail folder
names.
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Setting Polling
Intervals for
Notifications
HEAT polls for mail and
alarms at set intervals. From
this screen you can set the
polling interval.

Set Polling Interval

Select User Preferences
from the Edit menu.

Click Mail.

Type a polling interval in
minutes, or click the arrow
keys to set the polling
interval.

Click OK.
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TIP
Your System Administrator may
define boundaries for your polling
order.
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Setting Alarm
Options
When an alarm fires, HEAT
can open the Alarm window
or display an icon in the
Status bar.
HEAT can also play a sound
when an alarm fires.

Set Alarm Options

Select User Preferences
from the Edit menu.

Click Mail.

Click Pop up when Alarm
fires to set the alarm window
to open.

Click Indicate Alarm in
Status Bar to set only the
icon to appear.

Click OK.
SEE ALSO
Setting Sounds, in this chapter.
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Setting E-Mail
Message
Options
You can set up defaults for e-
mail messages.
Select �Save to Outbox� to
automatically save a copy of
your e-mail message to your
outbox for later reference.
Select �Always Attach Current
Call� to automatically attach a
currently displayed Call
Record to an e-mail message.
Both defaults may be
overridden at any time from
the e-mail message itself.

Set E-Mail Message
Options

Select User Preferences
from the Edit menu.

Click Mail.

Select the Always Save to
Outbox check box to save
this message in your outbox
to refer to later.

Select the Always Attach
Current Call check box to
attach a currently displayed
Call Record to a SupportMail
message.

Click OK.
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Set Folder Labels

Select User Preferences
from the Edit menu.

Click Mail.

Type the name of the Inbox,
Outbox, and Drafts folders
in their respective fields.

Click OK.

Setting Folder
Labels
You can rename the three
SupportMail mail folders.
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The VIM/MAPI Tab
From the VIM/MAPI tab, set up VIM and MAPI settings for
external e-mail.
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Setting Up
External
E-Mail
HEAT supports external
e-mail systems using either
VIM or MAPI formats. You can
enable or disable either format.
Both mail types are disabled
by default.
You can read all messages, or
only unread messages.
A mail system may run faster
when set to display only
unread messages.

Set Up External
E-Mail

Select User Preferences
from the Edit Menu.

Click VIM/MAPI.

To enable VIM, click the VIM
Disable check box to
remove the check.

To enable MAPI, click the
MAPI Disable check box to
remove the check.

Enter your user name.

Enter your password.

Click the Show Only
Unread Messages check
box to show only unread
messages.

Click OK.
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The Location Tab
From the Location tab, set the language used at your support
center, the time zone offset between your support center and
the main database, and the default data source.
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Selecting the
HEAT Display
Language
You can run HEAT in one of
several languages. You can
select the language to run at
your support center.
To use this feature you must
first install HEAT with the
appropriate language. Only
installed languages appear in
the Select Application
Language dialog box.

Select the Language

Select User Preferences
from the Edit menu.

Click Location.

Click Select.

Select a language.

Click OK.

Click OK.
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Setting the
Default Data
Source
HEAT connects to your
database via an ODBC data
source that you select when
you launch Call Logging.
If you specify a default data
source, HEAT will not prompt
you to select a data source
when you log in.
Select an existing data source
by clicking the Select button.

Select a Default Data
Source

Select User Preferences
from the Edit menu.

Click Location.

Click Select in the Default
Data Source field.

Select a data source.

Click OK to exit.
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Setting the
Time Zone
Offset
When a support center and its
database are in two different
time zones, collecting and
saving data with reference to a
single time zone can be
critical. You can set the time
zone offset from the database,
allowing your computer and
the database to exchange data
at the same numerical time.
The Time Zone Offset shows
the difference in hours
between your time zone and
the database�s time zone.

Set the Time Zone
Offset

Select User Preferences
from the Edit menu.

Click Location.

Set the Time Zone Offset
from Main Database. The
number should equal the
difference in hours between
your location and the main
database.

Click OK.

TIP
This feature must be enabled in the
Administrator Module by your
system administrator.

1

2

3

4

4

2

3

1



USER PREFERENCES 10-25

The Paths Tab
From the Paths tab, set paths to Crystal Report Writer, and
report and knowledge base executable files
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Setting Paths
to Programs
and
Information
HEAT searches for the Crystal
Report Writer application, its
reports, and the Knowledge
Base search engine in their
assigned directories.
Use the same procedure to set
each path. The example shows
how to set a path to FLS.

Set a Path

Select User Preferences
from the Edit menu.

Click Paths.

Click Browse for the
appropriate application.

Locate the path to the
application.

Click Open.

Repeat steps 3-5 for each
path.

Click OK.7
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The Sounds Tab
From the Sounds tab, set sounds to be associated with HEAT
functions.
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Setting
Sounds
You can assign sounds to
several HEAT tasks and
functions. A sound can alert
you or confirm that a task is
done. You must have a sound
card and speakers to play
these sounds.
You can associate a sound
with each of these events:

� Message�Incoming mail
message.

� Alarm�Expired alarm.

� HEATBoard Issue�Issue
has been posted to the
IssueBoard

� New Call�Opening a new
Call Record.

� Save Call�Saving a Call
Record.

� Abort Call�Abandoning a
Call Record.

� Quick Close�Quick-closing
a Call Record.

� Solution Found�First Level
Support finds a solution to
the current problem.

Set a Sound

Select User Preferences
from the Edit menu.

Click Sounds.

Click the HEAT event for
which you want a sound.

Click Browse.

Select a .wav sound file.

Click Open. A speaker icon
appears next to the event,
indicating that the event has
an associated sound.

Repeat steps 3-6 for each
sound you want.

Click OK.
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The HEATBoard Tab
From the HEATBoard tab, set HEATBoard Issue sorting
options and HEATBoard teams.



10-30  CALL LOGGING AT A GLANCE

Sorting
HEATBoard
Issues
You can sort the issues
displayed on the HEATBoard
by:

� The person who posted
the issue

� Posted date and time
� Date and time last

modified
� Expiration date and time

Sort Issues

Select User Preferences
from the Edit menu.

Click HEATBoard.

Click a sorting criterion.

Click a sorting direction.

Click OK.5
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Selecting
IssueBoard
Teams
You can select the teams
displayed on HEATBoard. By
default, HEATBoard displays
the teams of which you are a
member.

Select Teams

Select User Preferences
from the Edit menu.

Click HEATBoard.

Select one or more teams.
Click Move Up to move up
the list. Click Move Down to
move down the list.

Select a method of
displaying team issues on
the HEATBoard.

� Show selected teams
separately puts all issues
pertaining to a team in a
team bar.

� Combine selected teams
shows all issues in one bar.

� Combine selected teams
except Global shows all
team issues in one bar, and
all Global issues in a Global
bar.

Click OK.

SEE ALSO
See Viewing HEATBoard Issues in
�Call Logging,� Chapter 2.
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The Call Map Tab
From the Call Map tab, set the Call Map display and Call
Map categories.
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Setting Call
Map
Categories
You can set the categories
displayed on the Call Map.
The available categories are
controlled by the system
administrator.

Set Call Map
Categories

Select User Preferences
from the Edit menu.

Click Call Map.

Select an available
category.

Click Move Up or Move
Down to move the selected
category higher or lower on
the list.

Click Add to move the
category from the Available
Categories into the
Selected Categories field
for your Call Map.

Click Remove to remove a
selected category from your
Call Map to the Available
Categories field.

Click OK.
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Setting the
Call Map
Display
You can set up the Call Map to
display or hide fields such as
names and call types. You can
also set up the Call Map to
display the number of
journals.

Set the Call Map
Display

Select User Preferences
from the Edit menu.

Click Call Map.

Choose what information to
display in the Call Map by
clicking the check boxes:

� Show Call Info Field Name
displays call information
such as call type and
status.

� Show Cust Info Field Name
displays customer info such
as title and address.

� Show Assignment Field
Name displays
assignments.

� Show Journal Field Name
displays journals.

� Show Assignment Count
displays the number of
assignments available.

� Show Journal Count
displays the number of
journals available.

Click OK.
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The Prompts Tab
Use the Prompts tab to set preferences for prompts within
the system. Set the preferences for saving calls, journals
and assignments without asking  or set the system to skip
�restoring saved call groups� on startup.
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Setting Prompt
Options

Use the Prompts tab in the
User Preferences dialog box to
define the prompts that Call
Logging provides.

On this screen, you can define
prompts to:

    �Automatically save calls
      without asking.

�Automatically save
journals without asking.

�Automatically save
assignments without
asking.

�Skip restore saved call
groups prompt on startup.

Set the user
prompts to
repress

Select User Preferences
from the Edit Meu.

Select the Prompts tab in
the User Preferences dialog
box.

Choose the user prompts
that  you would like to
repress in the application.

Click OK.
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Function Keys

Online Help ............................................................................................. F1
Clear a date or time field ....................................................................... F2
Fill in System Date/Time ......................................................................... F3
Display Calendar in a date field ............................................................ F4
Profile ..................................................................................................... F5
Switching Between Upper and Lower Panes ..................................... F6
Validations ............................................................................................. F9
Quick Close .......................................................................................... F10
SupportMail .......................................................................................... F11
Alarms ....................................................................................... Shift+F11
Autosize the Subset ............................................................................ F12
First Call ....................................................................................... Shift+F7
Previous Call .......................................................................................... F7
Next Call ................................................................................................. F8
Last Call ....................................................................................... Shift+F8

Navigation Keys
Call Log ............................................................................................. Alt+1
Detail ................................................................................................. Alt+2
Assignment ....................................................................................... Alt+3
Journal .............................................................................................. Alt+4
Current Call Information ............................................................ Ctrl+Alt+C
Show InfoCenter ........................................................................ Ctrl+Alt+I
Go to Call Map .......................................................................... Ctrl+Alt+M
Go to HEATBoard ..................................................................... Ctrl+Alt+B
Moves cursor to next field .................................................................. Tab
Move back one field .................................................................. Shift+Tab
Moves Cursor within a field ..................................................... ç and è
Scrolls text in a memo field ........................................................é and ê
Moves cursor one word to the left ............................................... Ctrl+ç
Moves cursor one word to the right ............................................. Ctrl+è
Moves cursor to the beginning of the line ....................................... Home
Moves cursor to the end of the line .................................................... End
Moves cursor to the beginning of text field ............................. Ctrl+Home
Moves cursor to the end of text field ......................................... Ctrl+End
Moves between call groups ....................................................... Ctrl+Tab
First Assignment/Journal ................................................. Ctrl+Shift+PgUp
Previous Assignment/Journal .................................................... Ctrl+PgUp
Next Assignment/Journal .......................................................... Ctrl+PgDn
Last Assignment/Journal ................................................. Ctrl+Shift+PgDn

Text Editing Keys
Deletes character to right ............................................................... Delete
Deletes character to left ........................................................ Backspace
Cut ................................................................................................... Ctrl+X
Copy ................................................................................................ Ctrl+C
Paste ................................................................................................ Ctrl+V
Undo ................................................................................................ Ctrl+Z
Use Spell Checker ....................................................................... Shift+F9

Printing Shortcut Keys
Print .................................................................................................. Ctrl+P
Print Active Call Group ........................................................... Ctrl+Shift+P
Print by Call Type ................................................................... Ctrl+Shift+B
Print Report ...................................................................................... Ctrl+R

Mail Shortcut Keys
Reply to Sender ............................................................................... Ctrl+R
Forward Mail ................................................................................... Ctrl+F
Go to Attached Call .......................................................................... Ctrl+A
Broadcasts ...................................................................................... Ctrl+B
Refresh Messages .......................................................................... Ctrl+E
Move ................................................................................................ Ctrl+V
Copy ................................................................................................ Ctrl+C

Other Shortcut Keys
New Assignment .............................................................................Ctrl+A
New Journal ..................................................................................... Ctrl+J
Displays the Call Record Browse Grid View ................................. Ctrl+B
Refreshes the Active Call Group
 (except  WorkGroup) ..................................................................... Ctrl+E
First Level Support .......................................................................... Ctrl+F
Perform a Search .................................................................. Ctrl+Shift+S
Go to the Call ID ............................................................................... Ctrl+G
Put a Call on Hold ............................................................................. Ctrl+H
Lock Call Record ............................................................................. Ctrl+L
Add Call to My Hot List ....................................................................Ctrl+M
New Call .......................................................................................... Ctrl+N
Open an existing Call Group ...........................................................Ctrl+O
Run Reports .......................................................................... Ctrl+Shift+R
Save ................................................................................................ Ctrl+S
Switch Customer Types .................................................................. Ctrl+T
Increment Counter Field ........................................................... Numpad +
Decrement Counter Field .......................................................... Numpad  -

Appendix A:  Keyboard Shortcuts
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Open New Call Record:  Creates a new
Call Record in the Call Log Screen.

Abandon Changes:  Closes the current
Call Record without saving any of the
information.

Save Changes:  Permanently records the
information for the current Call Record.

Quick Close:  Closes the current Call
Record and saves it immediately.

Print Call Ticket:  Prints the current Call
Record.

Validate Field:  Opens a window which
displays a list of legal values for the
currently selected field.

Run Spell Check:  Checks spelling in the
currently selected field.

Cut:  Cuts the selected information to the
Clipboard, removing it from the field.

Copy:  Copies the selected information to
the Clipboard.

Paste:  Inserts the information from the
Clipboard into the currently selected field of
the Call Record.

Open Call Group:  Opens the Call
Group selection window.

Show Caller History:  Lists all calls for
the current customer.

Call Record Browse:  Lists all calls in
the current Call Group.

First Level Support:  Launches the First
Level Support knowledge base.

Customer Configuration:  Opens the
Configuration Record for the current
customer.

Customer Profile:  Opens the Profile
Record for the current customer.

Last Call Record:  Opens the last record
in the active Call Group.

Next Call Record:  Opens the next
record in the active Call Group.

Previous Call Record:  Opens the
previous record in the active Call Group.

First Call Record:  Opens the first
record of the active Call Group.

CTRL+N

CTRL+S

F10

CTRL+P

F9

SHIFT+F9

CTRL+X

CTRL+C

CTRL+O

CTRL+B

SHIFT+F7

SHIFT+F8

F7

F8

F5

CTRL+F

Appendix B:
Default Toolbar Buttons

Refresh Group:  Adds calls that have
been added to the database since the Call
Group was opened.

View Contacts:  Lists all contacts for the
current Call Record.

New Call Group:  Creates a new Call
Group.

CTRL+V

CTRL+E
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Appendix C:   @Functions

@Functions
@Functions are fields that let you customize data based on variable criteria. For example, instead of using a new
lookup for each Tracker, you can automatically use the current Tracker�s ID.

How they work
The functions basically work by replacing the text of the function call with actual values before the SQL statement
is sent to the ODBC data source.

(

(

(

(
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Index
IN THIS CHAPTER

Acknowledging
Assignments, 9-16

Alarms
Setting Notifications, 
9-24

Alerts
Defining Actions, 9-5
Defining Sounds, 9-6
Deleting, 9-13
Editing, 9-12
Preferences, 9-25
Saving, 9-20
Viewing, 9-21

Away From Desk, 9-17
Call Group Alerts

Defining, 9-4
Launching Call Logging, 

9-18
Logging On, 9-2
Paging

Set Alert, 9-9
Utilities, 9-26

Polling
Defining, 9-14
Start, 9-15
Stop, 9-15

Run Program, 9-8
Run Task, 9-3

Running Program as Alert,
9-11

Setting Start-Up Options,
9-27

Start-Up Menu
About, 9-3

SupportMail
E-Mailing Pager, 9-10
Sending E-Mail, 9-7
Setting Alerts, 9-23

Viewing Journals, 9-22
Alerts. See Alert Monitor
AND Connector, 5-18
Answer Wizard Reports

About, 7-2
Assignment Tab, 2-9
Assignments

Abandoning, 2-18
Acknowledging, 2-20
Acknowledging in Alert

Monitor, 9-16
Creating in AutoTask, 8-17
Resolving, 2-21
Viewing, 2-19

Attachments

A

Index

Symbols

% Wildcard, 5-13, 5-15,
5-16

.DAT, 6-6

.DST, 6-6
@Functions

About, 8-33, Ap-3
How they work, Ap-3
Inserting in AutoTask, 8-33

Activity Logs
Adding Records, 5-7
Creating in AutoTask, 8-14
Deleting Records, 5-9
Editing Records, 5-8
Viewing, 5-6

Alarms
Creating in AutoTask, 8-7
Options, 10-16
Setting Notifications, 9-24

Alert Monitor
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Adding
E-Mail to a Call Record,
9-37
Files, 6-16
Files to an E-Mail, 8-10
Files to Call Record, 
2-31

Editing, 2-32
Removing, 2-33
Viewing

Call Record to an E-
Mail, 9-38
E-Mail to a Call Record,
9-39
Files, 6-16

Auto Search Intervals, 10-6
AutoClosing

from Menu, 2-60
from Toolbar, 2-60

Autopopulating, 6-24
AutoTask

Adding All Assignments, 
8-31

Adding All Journals, 8-31
Attaching Files, 8-10
Call Templates, 8-23
Call Tickets, 8-23
Changing Action Order, 

8-25
Creating

Activity Logs, 8-14
Alarms, 8-7
Assignments, 8-17
Call Records, 8-15
Complex Tasks, 8-24
Folders, 8-4

Journals, 8-19
Menu Items, 8-30
Tasks, 8-5, 8-6
Toolbars, 8-29

E-mail, 8-23
Editing

Actions, 8-27
Blocks, 8-41
Tasks, 8-23

Follow-up Calls, 8-23
Form Letters, 8-23
Formatting Counters, 8-40
Forwarding Unread Mes-

sages, 8-9
Inserting

@Functions, 8-33
Assignments, 8-36
Blank Values, 8-37
Counters, 8-39
Fields, 8-32
File Names, 8-34
Information into Actions,
8-31
Journals, 8-36
New Lines, 8-38
Temporary File Names,
8-35
Variables, 8-31

Paging, 8-23
Printing Call Tickets, 8-13
Remote Control, 8-23
Removing

Actions, 8-26
Tasks, 8-26

Running

from AutoTask Window,
8-2
from Menu, 8-3
from Toolbar, 8-3
Programs, 8-11

Sending Messages, 8-8
Updating Call Records,

8-21
Writing Files to Disk, 8-12

Blank Values
Inserting in AutoTask, 8-37

Blocks
Editing in AutoTasks, 8-41

Boolean Search
About, 5-18, 5-19
Creating Call Groups from,

4-5
Editing, 4-11
Modify Scope, 5-20

Branches. See also Knowl-
edge Trees: Nodes

About, 6-3
Broadcast Messages

About, 9-28
Deleting, 9-43
Editing, 9-42
Sending, 9-41

Call Counter
About, 2-5
Quick Keys, 10-5

Call Group Alerts

Action Screen, 9-5
Defining, 9-4
Deleting, 9-13
Editing, 9-12

Call Groups
About, 2-2, 4-2
Creating

from Boolean Search, 
4-5
from Simple Search, 4-8

Creating Hot Lists, 4-14
Deleting, 4-13
Editing, 4-9
Editing Criteria, 4-10
Hot Lists, 4-2
My Hot List, 4-18
Opening, 4-3
Predefined, 4-2
Put on Hold, 4-4
Saving Search Criteria, 

4-12
Call History, 3-20

Chronology, 10-10
Searching, 5-21
Viewing, 3-21

Call ID
About, 2-5

Call ID Number
About, 2-2

Call Logging
Call Status Banner, 2-5
Launching, 2-3
Launching from Alert

Monitor, 9-18, 9-19
Menu Bar, 2-5
Options, 2-12

C

B
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Screen, 2-4
Sending E-Mail from, 9-35
Toolbar, 2-5

Call Logging Reports
About, 7-9

Call Logging Tab, 2-7
Call Map

Categories, 10-33
Display, 10-34
Opening, 2-49
Using, 2-50

Call Map Tab, 10-32
Call Records

About, 2-2
Assigning, 2-17
Attaching Files, 2-31
Browsing, 5-3
Closing, 2-35
Creating, 2-14
Creating in AutoTask, 8-15
Documenting Actions, 2-22
Filling Out, 2-15
Finding All for a Customer,

5-2
Holding, 2-30
Locking, 2-28
My Hot List, 4-18
Post Solutions, 6-25
Previewing, 7-10
Printing, 7-11
Printing for a Call Group,

7-12
Put on Hold, 4-4
Saving, 2-34
Searching, 5-2

by ID Number, 5-4

Searching Transferred
Calls, 5-5

Unlocking, 2-28
Updating, 2-29
Updating in AutoTask, 8-19
Viewing, 2-16
Viewing Attached E-Mail,

9-39
Call Status Banner, 2-5
Call Templates

About, 8-23
Call Tickets. See also Call

Records
About, 8-23

Configuration Fields
Display, 10-13

Configuration Records, 3-12
Adding, 3-14
Copying, 3-16
Deleting, 3-17
Editing, 3-15
Moving, 3-16
Searching, 5-21
Viewing, 3-13

Contacts Records, 3-7
Adding, 3-9
Deleting, 3-11
Editing, 3-10
Searching, 5-21
Viewing, 3-8

Control Buttons, 2-12
Counters

Formatting in AutoTask, 
8-40

Inserting in AutoTask, 8-39
Using, 2-39

Crystal Reports
About, 7-3
Displaying, 7-5
E-Mailing, 7-8
Printing, 7-6, 7-13

by Call Type, 7-14
Running, 7-4
Saving, 7-7
Setting Path, 10-26

Customer ID
About, 2-2

Customer Records
About, 2-2
Viewing, 3-2

Customer Type
About, 2-2

Customer Window
Sending E-Mail from, 9-36

Data Source
Setting Default, 10-23

Default Toolbar Buttons, Ap-2
Detail Tab, 2-8
Display

Customizing, 10-3
Display Language, 10-22
Display Tab, 10-2
Distributions Files

Importing, 6-7
Documentation

Administrator Manual, 1-3

E-Mail. See also
SupportMail

About, 9-28
Broadcast Messages

Deleting, 9-43
Editing, 9-42
Sending, 9-41

Creating Folders, 9-44
External, 10-20
Folder Labels, 10-18
Messages

Attaching to Call
Record, 9-37
Copying, 9-46
Deleting, 9-31
Forwarding, 9-33
Forwarding Unread, 9-40
Moving, 9-45
Replying to, 9-32
Saving, 9-31
Sending from Call
Logging, 9-35
Sending from Customer
Window, 9-36
Sending from Mail
Window, 9-34
Setting Preferences, 
10-17
Viewing, 9-30
Viewing Attached Call
Records, 9-38
Viewing Attached to Call
Records, 9-39

Polling Interval, 10-15

D

E
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Journal Tab, 2-10
Journals

Abandoning, 2-24
Creating, 2-22
Creating in AutoTask, 8-19
Editing, 2-25
Spell Checking, 2-23
Viewing, 2-26

Keyboard Shortcuts, Ap-1
Function Keys, Ap-1
Mail Shortcut Keys, Ap-1
Navigation Keys, Ap-1
Other Shortcut keys, Ap-1
Printing Shortcut Keys,

Ap-1
Text Editing Keys, Ap-1

Knowledge Trees. See also
FLS

About, 6-6
Closing, 6-5
Copying Text, 6-26
Creating, 6-30
Exporting, 6-9
Importing, 6-8

Distribution Files, 6-7
Generic Files, 6-7

Nodes
About, 6-3
Adding, 6-14
Autopopulating, 6-24
Copying, 6-26

HEATBoard
AutoClosing Calls, 2-60
Controls, 2-52
Issue Group

Opening, 2-59
Issues

Creating, 2-54
Details, 2-52
Editing, 2-55
Linking, 2-56
Setting Lead Call, 2-58
Unlinking, 2-57
Viewing, 2-53

Opening, 2-51
Tab, 10-29
Teams, 10-31
Using, 2-52

Hot Lists
About, 2-2, 4-2
Adding Records, 4-17
Creating

from Menu, 4-14
from Open Call Group, 
4-15

Deleting, 4-20
Editing, 4-19
Opening, 4-3
Removing Calls, 4-21

InfoCenter, 2-11

Starting, 9-29

Fields
About, 8-31
Inserting in AutoTask, 8-32

File Names
Inserting in AutoTask, 8-34

Finding Information. See
Searching

FLS
Accessing

from Menu, 6-2
from Toolbar, 6-2

Adding Attachments, 6-16
Autopopulating, 6-24
Calculating Confidence

Values, 6-21
Changing User Status, 6-

13
Copying Text, 6-27
Customizing, 6-31
Defining Paths, 6-10
Defining Support Path,

6-10
Distribution Files, 6-7
Knowledge Trees

About, 6-6
Closing, 6-5
Creating, 6-30
Editing Nodes, 6-15
Exporting, 6-9
Importing, 6-8
Opening, 6-4
Printing, 6-29

Search Multiple, 6-20
Searching, 6-19
Sorting, 6-17

Links
Adding, 6-32
Deleting, 6-33
Rearranging, 6-33

Nodes
Adding, 6-14
Autopopulating, 6-24
Copying Text, 6-26
Printing, 6-28
Searching, 6-23

Noise Words, 6-18
Passwords

Removing, 6-12
Setting, 6-11

Posting Solutions, 6-25
Printing, 6-28
Printing Branches, 6-28
Printing Nodes, 6-28
Search Results, 6-22

FLS Window, 6-3
Follow-up Calls

About, 8-23
Form Letters

About, 8-23
Form View, 10-10
Function Keys, Ap-1

Generic Files, 6-6
Grid Settings Tab, 10-9
Grid View, 10-10
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Editing, 6-15
Printing, 6-28
Searching, 6-23

Opening, 6-4
Printing, 6-29
Printing Branches, 6-28
Searching, 6-19
Searching Multiple, 6-20
Sorting, 6-17

Location Tab, 10-21
Logical Connectors. See

Logical Operators
Logical Operators

AND, 5-18
Examples, 5-18
Modifying Scope, 5-20
OR, 5-18

Mail Shortcut Keys, Ap-1
Mail Tab, 10-14
Menu Bar, 2-5
Menu Item

Create in AutoTask, 8-30
My Hot List

About, 4-18
Adding Records, 4-16
Opening, 4-18

Navigation Keys, Ap-1
New Lines

Inserting in AutoTask, 8-38

Nodes. See Knowledge
Trees

Noise Words, 6-18

OR Connector, 5-18
Other Shortcut Keys, Ap-1

Paging
by Alert Monitor, 9-9
in AutoTask, 8-23
Specific Paging Utility, 

9-26
Passwords

Changing, 10-8
Removing, 6-12
Setting, 6-11

Paths
Setting

to Crystal Reports, 10-
26
to FLS, 10-26
to Reports, 10-26

Paths Tab, 10-25
Polling Interval

About, 9-14
Defining, 9-14
Poll Now, 9-15
Starting, 9-15
Stopping, 9-15

Predefined Call Groups
About, 4-2

Printer

About, 5-18
by ID Number, 5-4
Call Records for a Cus-

tomer, 5-2
Characters

Anywhere in Word, 5-16
At Beginning of Word, 
5-15

Knowledge Trees, 6-19
Multiple, 6-20
Results, 6-22
Text, 6-23

Search Criteria, 4-12
Table Entries, 5-10
Transferred Calls, 5-5
with Logical Operator, 5-17
with Wildcards, 5-13

Simple Search
About, 5-17
to Create Call group, 4-8

SLA Agreement
About, 2-6

Sorting Order, 5-10
Sounds

Setting, 10-28
Sounds Tab, 10-27

Set up in AutoTask, 8-13
Printing Shortcut Keys, Ap-1
Profile Records, 3-3

Creating, 3-4
Deleting, 3-6
Editing, 3-5
Searching, 5-21

Profile Subset, 2-6

Quick Search
About, 5-13
Characters

Anywhere in Word, 5-16
At Beginning of Word, 
5-15

Select Another Field, 5-14
Validated Fields, 5-13
Wildcards, 5-13

Remote Control
About, 8-23

Reports. See also Answer
Wizard Reports; Crystal
Reports

Roles, 1-3

Searching. See also Bool-
ean Search; Quick-
Search; Simple Search

Boolean Search
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Records, 9-38
Viewing Attached to Call
Records, 9-39

Polling Interval, 10-15
Starting, 9-29

Synchronized Displays, 5-3

Table Entires
Searching, 5-10

Tabs, 2-12
Tasks and Actions, 8-23
Team Category Bars, 2-52
Teams

About, 1-3
Selecting for IssueBoard,

10-31
Temporary Filenames

About, 8-31
Inserting in AutoTask, 8-35

Text Editing Keys, Ap-1
The Profile Subset, 2-2
Time Zone Offset, 10-24
Time-Zone Offset, 10-24
Toolbar, 2-5

Adding Buttons, 2-40
Create a Button in

AutoTask, 8-29
Creating, 2-42
Customizing, 2-40
Deleting, 2-46
Loading, 2-48
Moving, 2-44
Removing Buttons, 2-41

Renaming, 2-45
Resetting, 2-47
Resizing, 2-44
Restoring, 2-47
Saving Role, 2-48

Tracker Information, 10-7
Transferred Call Records

Searching, 5-5

User Preferences
Alarm Options, 10-16
Assignment View, 10-11
Auto Search Intervals, 10-6
Call History Chronology,

10-10
Call Map

Categories, 10-33
Display, 10-34

Call Map Tab, 10-32
Config Fields, 10-13
Counting Calls, 10-5
Display, 10-3
Display Language, 10-22
Display Tab, 10-2
E-Mail Message Options,

10-17
External E-Mail, 10-20
Folder Labels, 10-18
Grid Setting Tab, 10-9
HEATBoard Issues

Sorting, 10-30
HEATBoard Tab, 10-29
HEATBoard Teams, 10-31

Spell Checking, 2-23
Status Bar, 2-13
Stopwatch

About, 2-5
Changing Time, 2-37
Using, 2-36

SupportMail
About, 9-28
Broadcast Messages

Deleting, 9-43
Editing, 9-42
Sending, 9-41

Creating Folders, 9-44
External, 10-20
Folder Labels, 10-18
Message Options, 10-17
Messages

Attaching to Call
Record, 9-37
Copying, 9-46
Deleting, 9-31
Forwarding, 9-33
Forwarding Unread, 9-40
Moving, 9-45
Replying to, 9-32
Saving, 9-31
Sending from Call
Logging, 9-35
Sending from Customer
Window, 9-36
Sending from Mail
Window, 9-34
Viewing, 9-30
Viewing Attached Call

Journal View, 10-12
Location Tab, 10-21
Mail Tab, 10-14
Notification Intervals, 10-15
Passwords, 10-8
Paths Tab, 10-25
Setting Paths, 10-26
Setting Sounds, 10-28
Sounds Tab, 10-27
TimeZone Offset, 10-24
Tracker Information, 10-7
VIM/MAPI Tab, 10-19

Users, 1-3
Users, Roles & Teams, 1-3

Validated Fields
About, 2-2
Searching, 5-13

Views
Global, 4-12
in AutoTask, 8-2
Personal, 4-12
Team, 4-12

VIM/MAPI Tab, 10-19

Wildcard, 5-13
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